
 
 

 

 

Product Documentation 

 

 

ER/Studio Team Server XE7 
User Guide 

 
Version 4.0.8 

 
 

   
   

 



 

© 2015 Embarcadero Technologies, Inc. Embarcadero, the Embarcadero Technologies 
logos, and all other Embarcadero Technologies product or service names are 
trademarks or registered trademarks of Embarcadero Technologies, Inc. All other 
trademarks are property of their respective owners. 

Embarcadero Technologies, Inc. is a leading provider of award-winning tools for 
application developers and database professionals so they can design systems right, 
build them faster and run them better, regardless of their platform or programming 
language. Ninety of the Fortune 100 and an active community of more than three million 
users worldwide rely on Embarcadero products to increase productivity, reduce costs, 
simplify change management and compliance and accelerate innovation. The 
company's flagship tools include: Embarcadero® Change Manager™, CodeGear™ RAD 
Studio, DBArtisan®, Delphi®, ER/Studio®, JBuilder® and Rapid SQL®. Founded in 
1993, Embarcadero is headquartered in San Francisco, with offices located around the 
world. Embarcadero is online at www.embarcadero.com. 

April, 2015   

 
Embarcadero Technologies  2 

http://www.embarcadero.com/


 

CONTENTS 
What Is ER/Studio Team Server ........................................................................................... 10 
Installation Notes for ER/Studio Team Server .................................................................... 11 

Minimum Requirements .................................................................................................... 11 
Hardware Requirements ............................................................................................... 11 
System Requirements .................................................................................................... 11 
ER/Studio Repository .................................................................................................... 12 
Supported Database Platforms .................................................................................... 12 
Important Information ................................................................................................... 12 
Supported Web Browsers ............................................................................................. 13 

Conflicts .............................................................................................................................. 13 
Prerequisites....................................................................................................................... 13 
Optional Features .............................................................................................................. 13 

Active Directory Users Support .................................................................................... 13 
Email Support................................................................................................................. 14 

Third-Party Software That Is Installed with ER/Studio Team Server .............................. 14 
Installing and Upgrading .................................................................................................. 14 
After Installing .................................................................................................................... 14 

Upgrade Notes for ER/Studio Team Server ........................................................................ 15 
Upgrading from Embarcadero CONNECT 3.0.x ............................................................ 15 
Upgrading from ER/Studio Portal 2.0.x ........................................................................... 15 
Upgrading from ER/Studio Portal 1.6.x ........................................................................... 16 

Upgrading ER/Studio Team Server ...................................................................................... 17 
User Guide ............................................................................................................................. 19 
Connecting to ER/Studio Team Server ............................................................................... 20 
Overview of User Configuration ........................................................................................... 21 
Changing the Default Limit of Filters per Filtering Option ................................................ 22 
Changing the Default Number of Results per Page ........................................................... 23 
Changing Your Email Address for Notifications ................................................................. 24 
Configuring Your User Profile ............................................................................................... 25 
Using Social Features ............................................................................................................ 26 

Interface for Social Users .................................................................................................. 26 
Interaction with Resources ................................................................................................ 26 

Searching ............................................................................................................................... 28 
Using Reports......................................................................................................................... 29 
Adding a Shared Report to Favorite Reports ..................................................................... 30 
Generating a Shared Report ................................................................................................ 31 
Sending Reports By Email .................................................................................................... 32 
Overview of the User Interface ............................................................................................. 33 

Page Index ......................................................................................................................... 33 
Global Search Box ................................................................................................................. 35 
Simple Search ........................................................................................................................ 36 
Simple Search Form .............................................................................................................. 37 
Search Results ........................................................................................................................ 38 

 
Embarcadero Technologies  3 



 

Results Header ................................................................................................................... 38 
Results Panel ...................................................................................................................... 39 
Filters Panel ........................................................................................................................ 40 

Search Results Configuration ............................................................................................... 44 
Column Header Actions .................................................................................................... 44 
Search Results Configuration Actions .............................................................................. 44 

Resource Pages ..................................................................................................................... 46 
Stream .................................................................................................................................... 47 

Stream Header ................................................................................................................... 47 
Stream Activity ................................................................................................................... 47 
Stream Sidebar .................................................................................................................. 48 

Discussions ............................................................................................................................. 49 
Followers ................................................................................................................................ 50 
Glossary Pages ....................................................................................................................... 51 

Glossary Pages Header ..................................................................................................... 51 
Glossary Pages Sidebar ..................................................................................................... 51 

Glossary Description ............................................................................................................. 53 
Details Column .................................................................................................................. 53 
Stewards Column ............................................................................................................... 53 

Children .................................................................................................................................. 54 
Manage Tab ....................................................................................................................... 54 

Term Pages ............................................................................................................................ 55 
Term Pages Header ........................................................................................................... 55 
Term Pages Sidebar .......................................................................................................... 55 

Term Description ................................................................................................................... 57 
Details Column .................................................................................................................. 57 
Stewards Column ............................................................................................................... 57 

Related Glossaries ................................................................................................................. 58 
Relate Tab .......................................................................................................................... 58 

Related Terms ........................................................................................................................ 59 
View Tab ............................................................................................................................. 59 
Match Tab .......................................................................................................................... 59 
Relate Tab .......................................................................................................................... 60 

Related ER Objects ............................................................................................................... 61 
View Tab ............................................................................................................................. 61 
Found In Tab ...................................................................................................................... 61 
Relate Tab .......................................................................................................................... 62 

Person Pages ......................................................................................................................... 63 
Person Pages Header ........................................................................................................ 63 
Person Pages Sidebar ....................................................................................................... 63 

Configure Profile ................................................................................................................... 65 
Following ................................................................................................................................ 67 
User Description .................................................................................................................... 68 
ER Object Pages .................................................................................................................... 69 

ER Object Pages Header .................................................................................................. 69 

 
Embarcadero Technologies  4 



 

ER Object Pages Sidebar .................................................................................................. 69 
Sidebar for Social Users ................................................................................................ 70 
Sidebar for Non-Social Users ........................................................................................ 70 

Alerts ....................................................................................................................................... 71 
Alert Condition Entries ...................................................................................................... 71 

ER Object Description .......................................................................................................... 73 
Data Source Pages ................................................................................................................ 76 

Data Source Pages Header ............................................................................................... 76 
Data Source Pages Sidebar .............................................................................................. 76 

Data Source Description ....................................................................................................... 78 
Details Column .................................................................................................................. 78 
Stewards Column ............................................................................................................... 79 

Related ER Models ................................................................................................................ 81 
View Tab ............................................................................................................................. 81 
Relate Tab .......................................................................................................................... 81 

Related Login Credentials .................................................................................................... 82 
View Tab ............................................................................................................................. 82 
Relate Tab .......................................................................................................................... 82 

App Pages .............................................................................................................................. 83 
App Pages Header ............................................................................................................ 83 
App Pages Sidebar ............................................................................................................ 83 

App Description .................................................................................................................... 85 
Details Column .................................................................................................................. 85 
Stewards Column ............................................................................................................... 85 

Server Code ........................................................................................................................... 86 
Server Code Examples .......................................................................................................... 87 

Delete All Terms ................................................................................................................ 87 
Add Steward to All Terms ................................................................................................. 87 

Group Pages .......................................................................................................................... 89 
Group Pages Header......................................................................................................... 89 
Group Pages Sidebar ........................................................................................................ 89 

Group Description ................................................................................................................. 91 
Details Column .................................................................................................................. 91 
Stewards Column ............................................................................................................... 92 

Login Page ............................................................................................................................. 93 
Navigation Menu ................................................................................................................... 94 
Navigation Menu (Basic) ....................................................................................................... 95 
Navigation Menu (DBArtisan) ............................................................................................... 96 
Navigation Menu (ER/Studio) ............................................................................................... 97 
Report Pages ......................................................................................................................... 98 

Report Pages ...................................................................................................................... 98 
Connection Activity Details .................................................................................................. 99 
Login Activity Details ........................................................................................................... 100 
Updated Object Details ...................................................................................................... 101 
Search Pages ........................................................................................................................ 102 

 
Embarcadero Technologies  5 



 

Search Page Body............................................................................................................ 102 
Search Page Sidebar ....................................................................................................... 103 

Global Search Page Sidebar ....................................................................................... 104 
Resource-specific Search Page Sidebar..................................................................... 105 

Search Pages Index ......................................................................................................... 105 
Glossaries ............................................................................................................................. 106 
Load CSV File ....................................................................................................................... 107 
New Glossary ....................................................................................................................... 108 
Terms .................................................................................................................................... 110 
New Term ............................................................................................................................. 111 
People .................................................................................................................................. 113 
ER Objects ........................................................................................................................... 114 
Data Sources ........................................................................................................................ 115 

Advanced Search Feature ........................................................................................... 115 
New Data Source ................................................................................................................. 116 
Apps ..................................................................................................................................... 118 
New App .............................................................................................................................. 119 
User Menu ............................................................................................................................ 120 

My Settings Context Menu Items ................................................................................... 121 
Activity .................................................................................................................................. 122 

Denials .............................................................................................................................. 122 
Users ................................................................................................................................. 122 
API Usage ......................................................................................................................... 123 
Web Site Usage ............................................................................................................... 123 

Admin Page ......................................................................................................................... 124 
Working with Resources...................................................................................................... 127 
Adding an Attachment Attribute to a Resource Type ..................................................... 128 
Deleting a Resource ............................................................................................................ 129 
Discussing Resources .......................................................................................................... 130 
Starting a Discussion about a Resource ............................................................................ 131 
Editing a Resource .............................................................................................................. 132 
Editing the Stewards of a Resource ................................................................................... 133 
Following Resources ........................................................................................................... 134 
Following a Resource .......................................................................................................... 135 
Posting a Comment to a Resource .................................................................................... 136 
Unfollowing a Resource ...................................................................................................... 137 
Manage User Permissions on a Resource ......................................................................... 138 
Manage Group Permissions on a Resource ...................................................................... 139 
Interacting with People ....................................................................................................... 141 
Loading Glossaries and Terms from a CSV File ................................................................ 142 
CSV Format to Load Glossaries and Terms ...................................................................... 143 

Properties that You Can Use in Your CSV File .............................................................. 143 
Glossary Properties ...................................................................................................... 144 
Term Properties ........................................................................................................... 145 
Custom Attributes ....................................................................................................... 145 

 
Embarcadero Technologies  6 



 

Examples of Valid CSV Files ........................................................................................... 146 
Single Glossary ............................................................................................................. 146 
Terms ............................................................................................................................ 146 

Searching for a Resource of a Specific Resource Type .................................................... 148 
Advanced Search ............................................................................................................. 148 
Favorite Searches ............................................................................................................ 148 

Working with Glossaries ..................................................................................................... 150 
Adding a Child to a Glossary .............................................................................................. 151 
Adding a Term to a Glossary .............................................................................................. 152 
Creating a Glossary ............................................................................................................. 153 
Glossary Tool Tip ................................................................................................................. 154 
Installing Glossary Tool Tips ............................................................................................... 155 
Working with Terms ............................................................................................................ 156 
Associating a Term with a Glossary ................................................................................... 157 
Associating a Term with an ER Object .............................................................................. 158 
Associating a Term with Another Term ............................................................................. 159 
Creating a Term ................................................................................................................... 160 
Linked Terms ........................................................................................................................ 161 
Matching a Term with ER Objects ..................................................................................... 162 
Working with ER Objects .................................................................................................... 163 
Associating an ER Object with a Term .............................................................................. 164 
Browsing ER Objects ........................................................................................................... 165 
Configuring Sensitive Data Alerts ...................................................................................... 166 
Adding a Sensitive Data Alert Condition .......................................................................... 167 
Deleting a Sensitive Data Alert Condition ........................................................................ 168 
Editing a Sensitive Data Alert Condition ........................................................................... 169 
Matching an ER Object with Terms ................................................................................... 170 
Using the Advanced Search of ER Objects ....................................................................... 171 
Searching for an ER Object Using the Advanced Search ................................................ 172 
Saving Favorite Searches .................................................................................................... 174 
Sending Searches By Email ................................................................................................ 175 
Writing an Advanced Search String ................................................................................... 176 

Using Logic Operators .................................................................................................... 176 
Making Mandatory or Excluding Words ........................................................................ 176 
Using Wildcard Characters ............................................................................................. 176 
Using the Similarity and Proximity Character ................................................................ 177 
Escaping Special Characters .......................................................................................... 177 

Working with ER Object Comments .................................................................................. 178 
Adding a Comment to an ER Object ................................................................................. 179 
Deleting a Comment from an ER Object .......................................................................... 180 
See the Comments to an ER Object .................................................................................. 181 
Watching ER Objects for New Comments ........................................................................ 182 
Working with ER Object Labels .......................................................................................... 183 
Editing the Labels of an ER Object .................................................................................... 184 
Working with Data Sources ................................................................................................ 185 

 
Embarcadero Technologies  7 



 

Associating a Data Source with an ER Model ................................................................... 186 
Associating a Data Source with a Login Credential ......................................................... 187 

View Tab ........................................................................................................................... 187 
Relate Tab ........................................................................................................................ 187 

Creating a Data Source ....................................................................................................... 189 
Data Source Fields for a Specific Database Management System ................................. 190 

DB2 LUW .......................................................................................................................... 191 
DB2 z/OS .......................................................................................................................... 191 
InterBase ........................................................................................................................... 191 
Firebird ............................................................................................................................. 192 
JDBC ................................................................................................................................. 192 
MySQL .............................................................................................................................. 192 
ODBC ............................................................................................................................... 193 
Oracle ............................................................................................................................... 193 

Connecting to Oracle with Alias ................................................................................. 194 
Connecting to Oracle with Connect Descriptor ....................................................... 194 
Connecting to Oracle with SID ................................................................................... 194 
Connecting to Oracle with Service Name ................................................................. 194 

SQL Azure ........................................................................................................................ 195 
SQL Server ........................................................................................................................ 195 
Sybase ............................................................................................................................... 195 
Sybase IQ ......................................................................................................................... 196 

Working with Login Credentials ......................................................................................... 197 
Creating Login Credentials ................................................................................................ 198 
Editing a Resource .............................................................................................................. 199 
Deleting Login Credentials ................................................................................................. 200 
Browsing Login Credentials ................................................................................................ 201 
Related Login Credentials .................................................................................................. 202 

View Tab ........................................................................................................................... 202 
Relate Tab ........................................................................................................................ 202 

Login Credential Pages ....................................................................................................... 203 
Login Credentials Pages Header ................................................................................... 203 
Login Credentials Pages Sidebar ................................................................................... 203 

Working with Groups .......................................................................................................... 205 
Creating a Group ................................................................................................................. 206 
Including Data Sources into a Group ................................................................................ 207 
Working with Apps .............................................................................................................. 208 
Creating an App .................................................................................................................. 209 
Troubleshooting .................................................................................................................. 210 

Cannot Connect to ER/Studio Team Server ................................................................. 210 
Unable to Connect ...................................................................................................... 210 
Template Could Not be Loaded ................................................................................ 210 

ER/Studio Team Server is not showing the Start Here page ....................................... 210 
Loading Pages Takes Too Much Time ........................................................................... 211 
Log Error Messages ......................................................................................................... 211 

 
Embarcadero Technologies  8 



 

tomcat\logs\<domain>.<date>.log .......................................................................... 211 
etlvar\log\log_<timestamp>\*.log ............................................................................ 212 

Synchronization Issues .................................................................................................... 212 
Glossary ................................................................................................................................ 214 

 

 
Embarcadero Technologies  9 



What Is ER/Studio Team Server 

What Is ER/Studio Team Server 
ER/Studio Team Server is a web-based tool to access, search, edit and manage 
enterprise metadata. It provides access to metadata from ER/Studio Repository, and it 
allows you to manage additional metadata, such as glossaries and terms or data 
sources. 

ER/Studio Team Server allows you to keep track of your metadata and discuss its 
evolution with other users. It also lets you create reports easily from your data and 
searches, and export them to different file formats. 

ER/Studio Team Server also enables you to: 

o Search for all kinds of data, such as data definitions and ER objects in any model 
of your ER/Studio Repository database, including ER/Studio Data Architect 
and ER/Studio Business Architect diagrams. ER/Studio Team Server has simple 
and advanced searching capabilities to find ER objects and other resources, as 
well as their reuse and impact analysis. 

o Browse all the contents of your ER/Studio Repository database, such as models 
and dictionaries, in a structured way. 

 

 
Using a web browser, you can access ER/Studio Team Server internally, via your 
corporate intranet, or externally, via the internet. This way, you can access all the 
information you need from anywhere. 
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Installation Notes for ER/Studio Team Server 

 

Installation Notes for ER/Studio Team 
Server 
These notes provide important information about installing ER/Studio Team Server. You 
should read this document in its entirety before any install or uninstall procedure. 

Minimum Requirements 
ER/Studio Team Server is a 32-bit server application that runs in a Microsoft Windows 
environment. Before installing ER/Studio Team Server, verify that your environment 
meets the hardware and operating system requirements. 

Hardware Requirements 

The minimum hardware requirements are: 

o CPU: 2 x 3.0 Ghz 

Note: Should you be running the minimum spec requirements, it is advised to 
reduce the maxThreads to a single thread. To do this, edit 
...tomcat>webapps>api>WEB-INF>ersportal-app.xml and change the line <property 
name="maxThreads" value="2" />, to have a value of "1" (a restart is required after 
saving the change). 

o RAM: 4 GB 

o Disk space: 740 MB for program installation. You will need additional space 
available for data storage, for example 100mb per diagram in the Repository. 

Recommended hardware: 

o CPU: 4 x 3.0 Ghz 

o RAM: 8 GB 

System Requirements 

Your machine must be running the Microsoft Windows operating system. The following 
versions of Microsoft Windows are supported: 

o Microsoft Windows 2012 Server 

o Microsoft Windows 2008 R2 Server 

o Microsoft Windows 2008 Server (32-bit or 64-bit) 

o Microsoft Windows 2003 Server (32-bit only) 
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Installation Notes for ER/Studio Team Server 

Note: ER/Studio Team Server can run on Windows XP, Windows Vista and Windows 
7-8, but this is not recommended for an operational system, only for testing purposes. 

o To install ER/Studio Team Server on Windows 7, you need to run the installer in 
Windows XP or Windows Vista compatibility mode. 

o If the SQL server is also running when installing on Windows 8, the instance 
needs to be part of the SQL server name. The services and protocols also need 
to be running or enabled as documented below for SQL Server 2014. 

ER/Studio Repository 

ER/Studio Team Server works against an installation of ER/Studio Repository. Prior to 
installing ER/Studio Team Server, you need a working installation of ER/Studio 
Repository. ER/Studio Team Server supports versions 6.0, and 6.5 of ER/Studio 
Repository. 

If you have enough RAM for both applications, we recommend that you install ER/Studio 
Team Server on the same machine where the ER/Studio Repository server is installed. 
Otherwise, the machine where you install ER/Studio Team Server must have network 
access (over a local network or over the Internet) to the machine where ER/Studio 
Repository is running. 

Supported Database Platforms 

The Reporting Repository is the database that ER/Studio Team Server uses to store the 
information that it gathers from the ER/Studio Repository. The Reporting Repository 
database also stores the reports from previous queries and the metadata they rely on. 

The Reporting Repository database may run on any of the following database platforms: 

o Oracle 9i, 10g, and 11g 

o IBM DB2 UDB 8.x, 9.x and 10.x Server  

Note: Before installing ER/Studio Team Server on the DB2 platform, you must first 
create the Reporting Repository database. Allocate 32K for the tablespace pagesize. 

Starting with CONNECT version 3.0.4, Unicode is supported. When installing DB2, UTF-
8 should be selected when configuring your DB2 DB. 

o Microsoft SQL Server 2005 to 2014 

Important Information 

Ensure that the database is set to case-insensitive, as case-sensitive is not supported. 
Also set the SQL Server Configuration Properties to allow SQL Server authentication. 
ER/Studio Team Server only supports SQL Server Authentication. 

When installing over SQL Server 2014 (any Operating System), use the SQL Server 
Configuration Manager and make sure that the following services are running: 
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SQL Server 
SQL Server Agent 
Also that following protocols are enabled: 
Shared Memory 
TCP/IP 
Named Pipes 

Supported Web Browsers 

The following web browsers are tested to work with ER/Studio Team Server. Other 
browsers may work, but are not officially supported: 

o Mozilla Firefox 

o Google Chrome 

o Microsoft Internet Explorer (7.0 or later) 

Conflicts 
Do not install ER/Studio Team Server on a system where ER/Studio Data Architect, 
ER/Studio Business Architect or a previous version of ER/Studio Team Server is 
installed. If the ER/Studio Team Server installer detects an installation of any of these 
applications, the installer asks you to uninstall these applications before you proceed. 

There may be naming conflicts between the ER/Studio Repository and the Reporting 
Repository. If both repositories are installed on the same database server, you should 
use different schema owners. 

Prerequisites 
To install ER/Studio Team Server: 

o The installation user account must have local administrative privileges. 

o The ER/Studio Repository server and the database server to be used for the 
ER/Studio Team Server Reporting repository must be running. 

o In order to install, you need to create first an empty database for ER/Studio 
Team Server, unless you already have a database and will be reinitializing it 
during the install. 

Optional Features 

Active Directory Users Support 

The installation must include configuration of LDAP functionality to allow directory 
service users to log in to ER/Studio Team Server. You can alternatively enable LDAP 
authentication after the installation. 
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Email Support 

SMTP server configuration must be done in order to fully support email notifications 
based on user activity. You can alternatively enable email support after the installation. 

Third-Party Software That Is Installed with ER/Studio 
Team Server 
ER/Studio Team Server depends on some third-party software that the ER/Studio Team 
Server installation wizard installs automatically on your system. That third-party includes: 

o Apache Tomcat 

o Pentaho BI Platform 

Installing and Upgrading 
If you meet the minimum requirements, you can proceed to install ER/Studio Team 
Server. See Installing ER/Studio Team Server. 

If you have installed a previous version of ER/Studio Team Server (for example, any 
version of Embarcadero CONNECT or ER/Studio Portal), see Upgrading ER/Studio 
Team Server. 

After Installing 
After the installation is complete, you must synchronize the ER/Studio Team Server 
database with the ER/Studio Repository database to ensure that it is up to date. 

See Installing ER/Studio Team Server, Next Steps for more information. 

See Also 
o Release Notes for ER/Studio Team Server 

o Upgrading from Previous Versions 
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Upgrade Notes for ER/Studio Team Server 

Upgrade Notes for ER/Studio Team 
Server 
These Upgrade Notes provide important information regarding the process of 
upgrading to Embarcadero Team Server 4.0 from a previous versions. 

Regardless of the process that you must follow to back up your licenses, which depends 
on the previous version that you are upgrading from and other factors, after you restore 
your licenses in your new ER/Studio Team Server 4.0 installation, you must log in as a 
super user and use the Manage Users page to assign different types of available 
licenses to your users. 

Note: Files saved in later versions of ER Studio Data Architect may not work with 
ER/Studio Team Server if they use new features. For example, if you use SQL Server 
2014 for your Physical Model in ER Studio DA 9.7, you will need to update to the 
corresponding version of ER/Studio Team Server for those files to synchronize. 

 

Upgrading from Embarcadero CONNECT 3.0.x 
If your previous installation is CONNECT 3.0.x, the installation with automatically detect 
an upgrade to ER/Studio Team Server. 

We always recommend backing up your data before starting the process. You may have 
to back up your database, Repository database and export your Glossaries and Terms. 
We also recommend that you back up any licenses. To do this, please follow the steps in 
Upgrading from ER/Studio Portal 2.0.x. 

Upgrading from ER/Studio Portal 2.0.x 
If your previous installation is ER/Studio Portal 2.x, you will need to back up your licenses 
manually. 

Make a copy of the license files, for example: license.txt, ao_12345678.txt or .slip until 
the upgrade has completed. Then copy to the license folder in the installation directory 
of the new ER/Studio Team Server installation folder. 

Depending on your installation location, you can find the license file in the program 
directory. For example: 

o C:\Embarcadero\ERStudio Portal 2.0\license 

If you have previously used the uninstaller, you may also have a license backup in the 
following location: 

o  
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 32-bit Windows: C:\Program Files (x86)\Common 
Files\ersEnterprisePortalBackup\license 

 64-bit Windows: C:\Program Files\Common 
Files\ersEnterprisePortalBackup\license 

o If you have installed ER/Studio Portal 2.0.x on one computer and now want to 
install ER/Studio Team Server on a different computer, there is no license to back 
up, so you must use the license file from the previous installation. Copy the 
license\license.txt file from the previous installation folder into the new ER/Studio 
Team Server installation folder. 

After copying over the license.txt file to the license folder within the installation folder of 
ER/Studio Team Server, log in to ER/Studio Team Server as a super user, select My 
Settings > Admin > Licenses and click Refresh for ER/Studio Team Server to recognize 
your licenses. 

Upgrading from ER/Studio Portal 1.6.x 
ER/Studio Portal 1.6.x uses two databases, the solution and the reporting repositories. 
Because of this, you need to follow these steps to upgrade to ER/Studio Team Server: 

1. Consolidate the two databases:  

1. Stop the Tomcat service and run the 1.6.x Portal Configuration Manager. 

2. Select the Solution Database tab. 

3. Change the connection information to match that of the Reporting 
database. 

4. Select Initialize Existing Database and click Apply. 

5. Click OK. The Solution tables will be placed into the Reporting database. 

6. Restart the Tomcat service. 

2. Log in to the Portal and make sure that everything works correctly. 

3. Uninstall Portal 1.6.x. 

4. Install ER/Studio Team Server. 

5. When prompted to specify the Reporting Database information, specify the 
connection information, select Connect to Existing Database, and click Next. 
You are prompted to specify the Solution database information. It should default 
to the Reporting database. 

6. Specify the password for the Reporting database and click Next. 

7. Finish the installation. 

8. After installing ER/Studio Team Server, synchronize ER/Studio Team Server with 
the ER/Studio Repository database to ensure that it is up to date. 
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Upgrading ER/Studio Team Server 

Upgrading ER/Studio Team Server 
Before you begin, please review the Upgrade Notes specific to your previous version 
and the Release Notes. 

To upgrade your ER/Studio Team Server installation to a newer version: 

1. Run the installer for ER/Studio Team Server, this will automatically uninstall your 
current ER/Studio Team Server installation. If you wish to uninstall your previous 
version of ER/Studio Team Server manually, please review, later in this topic, the 
information regarding keeping your licenses. 

2. Install your new version of ER/Studio Team Server. 

Supported Versions for Upgrading 

Upgrading releases of ER/Studio Portal prior to 2.0 is not supported for this release. 
Please review the Upgrade Notes for further information. 

Note: In previous versions of ER/Studio Portal it was possible to split the Reporting 
and Solutions database in two separate databases. If you have your Portal data in two 
separate servers, you will need to use your database supporting client tools to merge 
the data into one database prior to installation. Team Server no longer uses the 
solution/reporting database structure. Should you have any concerns regarding this, 
please contact Support before starting your upgrade. 

Keeping Your Licenses When Upgrading 

If you have previously installed ER/Studio Portal 2.x you will need to manually back up 
your license file as explained below. If you are upgrading from Connect 3.x the 
Embarcadero Connect installer will automatically back up and use your existing add-on 
license files. But there are two exceptions: 

o You are upgrading and during the installation you choose a different Reporting 
repository than the one used in your previous installation. In this case you must 
copy the license.txt file from the backup directory to the license directory in the 
new Embarcadero Connect license directory, <installation folder>\license\ . 
Depending on the operating system, you can find the license file at one of these 
backup locations:  

 C:\Program Files (x86)\Common Files\ersEnterprisePortalBackup\license 

 C:\Program Files\Common Files\ersEnterprisePortalBackup\license 

o You have installed a previous version on one computer and now want to install 
Embarcadero Connect 3.0 on a different computer. In this case, there is no 
license to back up so you must use the license file from the previous installation. 
Copy the license.txt file from the previous installation to the new installation. The 
license file resides in <installation folder>\license\ . 
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Upgrading ER/Studio Team Server 

After copying over the license file to <installation folder>\license\ , from the 
Embarcadero Connect console, go to Admin > Licenses, and click Refresh so that 
Embarcadero Connect recognizes and uses the license. 

Reports Update when Upgrading 

This section explains how to deal with the upgrade from previous versions when the 
adhoc report metadata changes with respect to the new version. Changes include 
adding new model into an adhoc report, or changing field name in the existing adhoc 
report. 

Note: The following instructions affect the upgrade from previous versions in which 
the adhoc report metadata changes with respect to the actual version. For example, the 
Connect Model option is not available until Connect 3.0.2. For this reason, when 
upgrading from releases prior to Connect 3.0.1 to versions Connect 3.0.2 or higher, you 
should follow these steps. Particularly, when upgrading from Connect 3.0.2, the Connect 
Model option appears on the New Report page but if you move to the next page, the 
custom attribute options are missing until these steps are executed. 

If the adhoc report metadata changes when you upgrade from a previous version, you 
should follow the following steps after installing the new version: 

1. Select My Settings > Admin > Repository Management. 

2. Click More button. 

3. Click on the options in the following order:  

1. Refresh Reporting Metadata. 

2. Execute Global Action. 

3. Refresh System Settings. 

4. Click Close. 

5. Click Update Solution Repository in My Settings > Admin > Repository 
Management. 

6. Wait until a message of successful update appears. 

After you upgrade ER/Studio Team Server 

o Update the search index. 

See Also 
o Installing ER/Studio Team Server 

o Uninstalling ER/Studio Team Server 
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User Guide 

User Guide 
This volume of help describes how to use ER/Studio Team Server as a authenticated 
user. 

Topics 
o Connecting to ER/Studio Team Server 

o Searching 

o Working with Resources:  

 Glossaries 

 Terms 

 People 

 ER Objects 

 Data Sources 

 Login Credentials 

o Using Reports 

o User Configuration 

o User Interface 

See Also 
o Overview of the User Interface 

o Administrator Guide 
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Connecting to ER/Studio Team Server 

Connecting to ER/Studio Team Server 

 
To connect to a running instance of ER/Studio Team Server: 

1. Open a web browser. See Supported Web Browsers. 

2. Browse to the ER/Studio Team Server URL, as provided by your super user. The 
web browser shows the ER/Studio Team Server login page.  

 Tip: If you are the super user, see Starting ER/Studio Team Server for 
more information. 

3. Enter your Username and Password, as provided by your super user. The default 
user being Admin > Admin. 

4. Optionally, click "Remember me" to store your user credentials in the web 
browser, so that you do not need to enter them again. 

5. Click Login. 

You should now be logged in to ER/Studio Team Server. If you are unsure of what to do 
next, the Start Here Page will guide you. 

For further information see the User Guide. 

See Also 
o Troubleshooting, Connecting to ER/Studio Team Server 

o Starting ER/Studio Team Server 

o Login Page 
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Overview of User Configuration 

Overview of User Configuration 
You can define your user preferences from the Preferences page. 

If you are a social user, you can customize additional user settings. For example, you can 
configure your user profile from the Configure Profile page, or choose in the 
Notifications page which activities you want to follow, so that you get email notifications 
about them. 

Topics 
o Configuring Your User Profile 

o Changing the Default Limit of Filters per Filtering Option 

o Changing the Default Number of Results per Page 

o Changing Your Email Address for Notifications 

See Also 
o Preferences page 

o Configure Profile page 

o Notifications page 
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Changing the Default Limit of Filters per Filtering Option 

Changing the Default Limit of Filters 
per Filtering Option 
When you perform an advanced search as a social user or any search as a non-social 
user, the search results page displays a panel with filtering options. 

By default, under each filtering option there is a list of up to 25 filters that you can apply 
to the current search. If more than 25 filters are available, you need to click , so that it 
becomes and the filter limit is ignored. 

To change the default limit of filters that are listed under each filtering option, do the 
following: 

1. Select My Settings > Preferences. 

2. Click Edit to make your preferences editable. 

3. Under Search, change the value of Default Filter Limitation to the desired 
value. The value must be a positive integer. 

4. Click Apply Changes to save your changes. 

See Also 
o Search Results page 

o Preferences page 
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Changing the Default Number of Results per Page 

Changing the Default Number of 
Results per Page 
The Comments page displays 10 results per page by default. To change this value: 

1. Select My Settings > Preferences. 

2. Click Edit to make your preferences editable. 

3. Under General, change the value of Results per Page to the desired value. The 
value must be a positive integer. 

4. Click Apply Changes to save your changes. 

See Also 
o Search Results page 

o Preferences page 
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Changing Your Email Address for Notifications 

Changing Your Email Address for 
Notifications 
To change the email address where you get ER/Studio Team Server notifications: 

1. Select My Settings > Preferences. 

2. Click Edit to make your preferences editable. 

3. Under Notifications, change the value of Email Address field to your new email 
address. 

4. Click Apply Changes to save your changes. 

See Also 
o Watching ER Objects for New Comments 

o Preferences page 
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Configuring Your User Profile 

Configuring Your User Profile 
When you are a social user, other social users can search for you and see details about 
you in your Description page. 

To configure the information in your description page: 

1. Open your person page. For example, click your username or user image in your 
Home page. 

2. Click Edit on the upper-right corner of your person page. 

3. In the Configure Profile page:  

1. In Photo, click Browse and select an image file that you want to represent 
you in ER/Studio Team Server. 

2. Fill Title with your job title. This field is mandatory. 

3. You can enter in First Name your display name, which ER/Studio Team 
Server displays in places such as the Stream subpage. 

4. Write a detailed description of your job responsibilities in Job 
Description. 

5. Fill your Phone number so other users can contact you by phone. 

6. Fill Email with your email address. 

7. Under Stream Moderation, you can check or uncheck the following 
options:  

 "Allow others to post to your stream". Check this option so that 
other users can post comments associated with your user. 

 "Allow others to comment on activity in your stream". Check this 
option so that other users can reply to items in your activity 
stream. 

8. Click Save Changes to save your changes. 

See Also 
o Configure Profile page 

o Interacting with People 
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Using Social Features 

Using Social Features 

 
ER/Studio Team Server provides two different user profiles: social and non-social. The 
social version of ER/Studio Team Server is a useful system for users to share their 
experiences with other users and keep track of the activity related to the resources of 
their interest. 

The content of this page focuses on the features that ER/Studio Team Server offers to 
social users. These features are not available for non-social users. See Overview of User 
Experiences to understand the main differences between these two experiences. 

Interface for Social Users 
You can access features and settings with the User Menu of the interface and search for 
any resource in the Reporting Repository using the Global Search Box option. The 
interface also includes a Navigation Menu with the main ER/Studio Team Server 
features. See Overview of the User Interface for more information about the interface. 

Interaction with Resources 

 
You can interact with any resource (glossaries, terms, ER objects, and data sources). 
Interaction includes having discussions (making comments) with other users about 
resources, tracking the changes and discussions related to resources and following 
people activity surrounding resources. For that purpose, you can use the following 
features: 

o Stream 

The Stream page shows the activity related to the current resource. This activity involves 
changes surrounding resources, such as start following a resource, as well as comments 
related to these changes. The activity stream is shown on the Home page and on the 
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Using Social Features 

current resource pages. On the Home page, you can filter the content in the activity 
stream. See Stream page for more information. 

o Discussions 

You can see and edit comments related to a resource using the Discussions Tab of the 
navigation sidebar. In the current resource page, you can select the Discussions option 
to see the conversation about this resource or start a new one. A discussion can be 
expanded to show other users' comments. Each entry displays the image, the username 
and the actual text of the author and the date when the author wrote the reply. See 
Discussing Resources for more information. 

Note: ER/Studio Team Server shows comments related to an ER Object made in 
ER/Studio Data Architect. To view the comments click the icon next to the ER Object in 
the Model Explorer. 

 
 

You can track other users' activity in relation to resources. This activity appears on the 
Home page when people that you are following edit resources, post comments to 
resources, and so on. The Following a Resource feature provides a practical tool for the 
personalization of the system according to the user's interests. See Following a Resource 
for more information. 

See Also 
o Overview of User Experiences 

o Overview of User Roles 

o Overview of the User Interface 

o Comment Moderation Page 
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Searching 

Searching 
ER/Studio Team Server provides search boxes on several pages, as well as a global 
search box. To use the subpage searches, start typing in the search box. As you type, 
the search results will start to match what you have typed. To use any global search box, 
just enter your search terms and press     ↵. 

If you are a social user, using the global search box you get a combination of the search 
results that you get when you use the searches for glossaries, terms, people, ER objects, 
and data sources. If you are a non-social user, the global search box lets you perform a 
simple search for ER objects. 

Both simple and advanced searches are executed against a search index that contains 
all searchable text properties of the ER objects in the Reporting Repository database. 
Super users can configure the search index so that searches ignore certain fields. 

Simple searches check all the searchable properties of any ER object in the Reporting 
Repository database for a partial match. After a simple search, ER/Studio Team Server 
provides a table with the matching ER objects. Each row in the search results provides a 
link to the ER object description page of the matching ER object, so that you can view 
more details on that ER object. At the top of the page you can click one of the letters to 
filter the search results to only those ER objects beginning with the chosen letter. 

If the standard search features are not enough for your use case, you can use the 
advanced search feature instead to look to ER objects, which allows you to refine your 
search with additional parameters and search string syntax features. You can configure 
your advanced search results page (click ), and you can save your advanced searches 
(click ) to access them later from the Favorite Searches page, where you can email 
them, print them, and share them. 

See Also 
o Advanced Search page 

o Search Pages 

o Configuring the Search Index 
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Using Reports 

Using Reports 
ER/Studio Team Server provides several standard reports. You can access the standard 
reports from the Solution Browser page. See Shared Reports for a list of available 
standard reports. 

When you execute a standard report, you are prompted to supply custom parameters 
that filter and format the results of the report. Those parameters depend on each other; 
that is, the value that you choose for one parameter determines the available values for 
other parameters. For example, if you select a certain project, you can only select 
diagrams that exist within the selected project. See Generating a Shared Report to learn 
how to use standard reports. 

ER/Studio Team Server lets you generate reports not only in HTML, but in PDF and XLS 
(Microsoft Excel spreadsheet) as well. You can save reports to run later and share them 
with other users. You can also print and email the reports. 

Using the Web Adhoc Query and Reporting wizard, you can create your own custom 
reports, and save them into the Solution Browser page, where you can organize them 
into folders. You can run your custom reports whenever you want, and you can share 
them with other users. 

The content of the custom reports is limited to the structured business views created 
using metadata. The metadata module generates SQL code based on business views 
that you specified during development. You can modify the business views using the 
Pentaho Metadata software. 

Topics 
o Generating a Shared Report 

o Adding a Shared Report to Favorite Reports 

o Sending Reports By Email 

See Also 
o My Reports 

o Solution Browser 

o Web Adhoc Query and Reporting Wizard 
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Adding a Shared Report to Favorite Reports 

Adding a Shared Report to Favorite 
Reports 
You can save the parameters of a shared report in your list of Favorite Reports, so you 
can later access the report easily. 

To make a shared report favorite: 

1. Open the Solution Browser page:  

 As a social user: ER Tools > Shared Reports. 

 As a non-social user: Shared Reports. 

2. Under Shared Reports, click either Business Reports or Technical Reports. 

3. Click the name of the report you want to make favorite. For additional 
information about the standard reports, see Shared Reports.  

Note: Users can see all shared reports, regardless of whether or not they have 
permission to access the ER objects that the report accesses. However, when users that 
try to run a report that access ER objects which users do not have permission to access, 
users get an error message instead of the results of the report. 

4. On the Shared Report Configuration Page page that opens:  

1. Choose the parameters for your report. 

2. In the View as combo box, choose the desired type of output for the 
report results: html, pdf or xls. 

3. Click Add to Favorites. 

2. In the Add to favorites dialog that opens:  

1. Enter a Name to save the report with in the Favorite Reports list. 

2. Write a Description for the report. 

3. Check the Shared checkbox if you want to make the shared report public. 

4. Click Submit to make the shared report favorite. 

After you save your new report as favorite, you can find it in the Favorite Reports page. If 
you are a non-social user, you can find your favorite reports in the Home page as well. 

See Also 
o Generating a Shared Report 

o Favorite Reports 

o Solution Browser 
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Generating a Shared Report 

Generating a Shared Report 
To generate a shared report: 

1. Open the Solution Browser page:  

 As a social user: ER Tools > Shared Reports. 

 As a non-social user: Shared Reports. 

2. Under Shared Reports, click either Business Reports or Technical Reports. 

3. Click the name of the report you want to run. For additional information about 
the standard reports, see Shared Reports.  

Note: Users can see all shared reports, regardless of whether or not they have 
permission to access the ER objects that the report accesses. However, when users that 
try to run a report that access ER objects which users do not have permission to access, 
users get an error message instead of the results of the report. 

4. On the Shared Report Configuration Page page that opens:  

1. Choose the parameters for your report. 

2. In the View as combo box, choose the desired type of output for the 
report results: html, pdf or xls. 

3. Click Run to generate the target report. 

See Also 
o Adding a Shared Report to Favorite Reports 

o Solution Browser 

o Shared Report Configuration Page page 
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Sending Reports By Email 

Sending Reports By Email 
If emailing reports is enabled, follow these steps to send a report by email: 

1. Open the Solution Browser page:  

 As a social user: ER Tools > Shared Reports. 

 As a non-social user: Shared Reports. 

2. Under Shared Reports, click either Business Reports or Technical Reports. 

3. Click the name of the report you want to make favorite. For additional 
information about the standard reports, see Shared Reports.  

Note: Users can see all shared reports, regardless of whether or not they have 
permission to access the ER objects that the report accesses. However, when users that 
try to run a report that access ER objects which users do not have permission to access, 
users get an error message instead of the results of the report. 

4. On the Shared Report Configuration Page page that opens:  

1. Choose the parameters for your report. 

2. In the View as combo box, choose the desired type of output for the 
report results: html, pdf or xls. 

3. Click Send by Email. 

2. In the Email Report dialog that opens:  

1. Specify in To an email address of the recipient. 

2. Click Submit to send the message. 

See Also 
o Generating a Shared Report 

o Adding a Shared Report to Favorite Reports 

o Enabling Emailing Search Results and Reports 

o Favorite Reports 
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Overview of the User Interface 

Overview of the User Interface 
The ER/Studio Team Server user interface consists of the following elements: 

 

o Global Search Box. Lets you search for any resource in the Reporting 
Repository. 

o User Menu. Provides access to user features and settings. 

o Navigation Menu. Provides access to the main ER/Studio Team Server features. 

o Navigation Sidebar. Lets you switch between the different pages of a major 
section. It changes depending on the current section. 

o Page Body. Shows the content of the current page. 

Page Index 
This is a list of pages and types of pages that you can find in ER/Studio Team Server: 

o Login Page 
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Overview of the User Interface 

o Resource Pages 

o Report Pages 

o Search Pages 

In the Navigation Menu we have eight tabs available: 

 

Tab Description 

Home Your personal home page, including Documentation links, getting started content 
videos and your Stream page showing your activity and the activity of resources 
you are following. 

Glossaries Web portal for your Glossaries, list, search, edit. 

Terms The Terms page is a search page that allows you to search for terms or create new 
terms. 

People The People page is a search page that allows you to search for ER/Studio TS users. 

ER Objects The ER Objects page is a search page that allows you to search for ER objects. 

ER Tools Allows you to navigate to the business and technical reports, and create custom 
reports. From here you can also access your favorite and shared searches and 
reports. 

Data 
Sources 

The Data Sources page is a search page that allows you to create or search for data 
sources or monitor current data sources. 

Apps The Apps page is a search page that allows you to create or search for 
applications. 

Groups The Groups page is a search page that allows you to create or search for 
applications. 

See Also 
o User Guide 
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Global Search Box 

Global Search Box 

 
The Global Search Box is a search box which is always available in the upper-right 
corner of the ER/Studio Team Server user interface. 

To perform a search, enter your search terms into the search box and press     ↵. 
What happens then depends on your type of user account: 

o If you are a social user, ER/Studio Team Server opens a global search page, a 
search page that includes every kind of resources: ER objects, people, glossaries, 
and so on. 

o If you are a non-social user, ER/Studio Team Server opens the Simple Search 
page with the results for your search. In this case, you can use special syntax 
features in your search string. 

See Also 
o Searching 

o Search Pages 

o Simple Search page 
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Simple Search 

Simple Search 
 

Global Search Box | enter a search string | press     ↵ (non-social users) 

This page lets you search ER/Studio Team Server for ER objects. 

The Simple Search page shows the results of your search at the top of the page, 
followed by the simple search form. 

See Also 
o Global Search Box 
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Simple Search Form 

Simple Search Form 
The simple search form is part of the Simple Search page. 

To preform a search, enter a search string into the search box and click the Search 
button. 

 

See Also 
o Global Search Box 

o Search Results 
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Search Results 

Search Results 
The search results frame is displayed: 

o In the Advanced Search page, after you perform an advanced search. 

o In the Simple Search page, after you perform a simple search as a non-social 
user. 

The search results for an advanced search have: 

o A header, on top, with several options and actions. 

o The results panel. 

o A panel with filters to apply to the search results. 

Results Header 
Above the search results, you can access the following options and actions: 
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Search Results 

Item Description 

View as 
table 
View as html 

Switches the search results view between the HTML view (default) and the table 
view. 

Hide details 
View details 
(HTML view) 

Hides or shows the details in the search results. 

If you hide the details, search results provide only show the breadcrumb trail and 
the relevance. See Results Panel. 

 
Add to 
favorites 

Opens a window to add the current advanced search to your list of Favorite 
Searches. See Saving Favorite Searches. 

 
Send by 
email 

Opens a window to send the current advanced search by email. See Sending 
Searches By Email. 

 
Print 

Opens a printable version of the current search results, and asks your web 
browser to print it. 

 
Configure 
this view 
(table view) 

Opens the Search Results Configuration page, where you can customize the 
search results table view. 

Order By 
(HTML view) 

Lets you configure the search field to sort the results, and the order, either 
ascending or descending. By default, most relevant results come first. 

Click a field name to select it to sort the results. The ascending ( ) or descending 
( ) icon is displayed on the right-hand side of the field name. You can click the 
field again to switch between ascending and descending order. 

Tip: You can further customize the search results using the table 
view with Configure this view. 

Results Panel 
In the results panel, the data matching the search string is marked in bold. 

While the data displayed is the same, the aspect of the results panel changes 
depending on the selected type of view: the HTML view or the table view. 

When you use the HTML view, each item in the list of results provides the following 
information: 

o In the first row, you can see:  

 An icon that identifies the type of ER object. 
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Search Results 

 The breadcrumb trail to the ER object, including the ER object itself. For 
example: Parent ER Object > Matching ER Object. Each ER object in the 
breadcrumb trail links to its ER object description page. 

 A percentage, between parenthesis, that represents the relevance of the 
matching ER object, given the search criteria used. 

o In the second row, you can see:  

 The date of the last modification to the matching ER object. 

 The author of the last modification to the matching ER object. 

o There are additional rows displaying a variety of property-value pairs. These rows 
depends on the ER object type of the matching ER object, for each ER object 
type a different set of rows is displayed. 

When you use the table view, ER/Studio Team Server displays the same data, but in 
columns: 

Column Description 

Object Name The name of the ER object. 

Object Type The type of ER object. 

Relevance The relevance of the matching ER object (in percentage), given the search 
criteria used. 

Modification 
Date 

The date of the last modification to the matching ER object. 

User Name The author of the last modification to the matching ER object. 

Path The breadcrumb trail to the ER object, including the ER object itself. For 
example: Parent ER Object > Matching ER Object. Each ER object in the 
breadcrumb trail links to its ER object description page. 

Property Type 
Property 
Value 

Property-value pairs that provide additional information about the ER object. 
The property-value pairs depend on the ER object type of the matching ER 
object, for each ER object type a different set of property-value pairs is 
displayed. 

Click a column name to select it to sort the results. The ascending ( ) or descending (
) icon is displayed on the right-hand side of the column name. You can click the column 
again to switch between ascending and descending order. 

Filters Panel 
The filters panel is displayed on the right-hand side of the results panel when you use 
the HTML view, or at the bottom of the results panel when you use the table view. 
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Search Results 

In the panel, you can find a variety of filtering options to apply to the search results. Each 
filtering option has the following appearance: 

Filter By <Filter type>  

<Filter name> (<Filter count>) 

<Filter name> (<Filter count>) 

... 

The following table explains each part of a filtering option in detail: 
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Search Results 

Item Description 

Filter type The type of filter. This can be: 

o Object Type(s), to filter the search results by the ER object type 
of the matching ER object. 

o An ER object type that one or more matching ER objects have 
as parent (for example, Diagram(s)), to filter the search results 
by common parent. 

/  
Hide / Show 
filters 

Click this icon to hide ( ) or show ( ) the filters available in the current 
filtering option. 

/  
Limited / 
Unlimited filters 

Click this icon to switch on or off the limit of filters that can be listed in the 
current filtering option: 

: Listed filters are limited. 

: All filters are listed. 

 
Make 
mandatory 

Adds the filter on the right-hand side of the icon to the list of active filters, as a 
mandatory filter. Only search results matching the selected filter are displayed. 

 
Make excluded 

Adds the filter on the right-hand side of the icon to the list of active filters, as 
an excluded filter. Search results matching the selected filter are not 
displayed. 

Filter name The name of the filter. The filters depend on the Field type: 

o If it is Object Type(s), each filter name is an ER object type (for 
example, Model or Entity). 

o If it is an ER object type, each filter is the name of an actual ER 
object that is a common parent to one or more ER objects in 
the search results. 

Filter count The number of matching ER objects in the search results that match the filter. 

When you add a mandatory ( ) or excluded ( ) filter to the list of active filters, 
ER/Studio Team Server displays the list of active filters after the last filtering option. The 
list of active filters has the following appearance: 

Current Active Filter(s)  

<Filter mode> <Filter type>: <Filter name>  

<Filter mode> <Filter type>: <Filter name>  

... 
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Search Results 

The following table explains each part of the list of active filters in detail: 

Item Description 

 
Remove 

You can click the icon on the left-hand side of Current Active Filter(s) to remove 
all active filters. 
Click the icon to the left-hand side of a specific filter to remove only that filter. 

/  
Filter 
mode 

This is an icon representing the filter mode, either mandatory ( ) or excluded ( ). 

Filter type The type of filter. For more information, see the table above. 

Filter 
name 

The name of the filter. For more information, see the table above. 

See Also 
o Using the Advanced Search of ER Objects 

 
Embarcadero Technologies  43 



Search Results Configuration 

Search Results Configuration 
 

Search Results | click  

The search results configuration page lets you customize the appearance of the table 
view in the Search Results page. 

This page displays the search results with editable column headers, so that you can 
remove or reorder the table columns, and a set of actions to interact with the page. 

Each value in the Property Type column has a icon on the right-hand side. You can 
click that icon to hide the target property type in the search results table. 

Below the table, there is a page navigation menu with page numbers and Previous and 
Next buttons that you can use to browse the pages of search results. 

Column Header Actions 
Each column header in the search results configuration table provides the following 
actions: 

Item Description 

 
Shift column to the left 

Switches the current column with the column on its left-hand side. 

 
Hide column 

Hides the current column. 

 
Shift column to the right 

Switches the current column with the column on its right-hand side. 

Search Results Configuration Actions 
At the top and at the bottom of the search results configuration page you can access the 
following actions: 
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Search Results Configuration 

Item Description 

Apply 
Changes 

Saves your changes to the search results table, and goes back to the Search 
Results page. 

Restore 
Defaults 

Restores the factory defaults, displaying all columns (in the default order) and 
property types. 

Cancel 
Changes 

Goes back to the Search Results page without saving your changes. 

See Also 
o Advanced Search page 
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Resource Pages 

Resource Pages 
While non-social users can only interact with ER objects, social users enjoy access to 
other kind of resources: glossaries, terms, people, and data sources. 

The pages of each one of those types of resources have a couple of things in common: 

 

o Navigation Sidebar. Allows you to switch between the different subpages of 
your resource. Different types of resource provide different subpages. 

o Resource Header. The resource header displays an icon representing the 
resource, the name of the resource, and some additional information and 
actions, depending on the type of the resource. 

o Subpage Body. This area displays the content of the resource subpage selected 
in the navigation sidebar. 

When you open a resource page, the Description subpage, common to all resource 
pages, is opened by default. 

See Also 
o Searching 
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Stream 

Stream 
The Stream page displays the activity associated with the current resource, such as 
changes or user comments. This page is only available for social users. 

This page contains of the following: 

o A header to write comments to the current resource and search or filter the 
activity. 

o The activity stream, which contains all kinds of activity entries associated with the 
current resource. 

o A sidebar on the right-hand side, which lists different data depending on the 
type of the current resource. 

Stream Header 
The header of the Stream page provides the following fields: 

Item Description 

Write a comment You can write a comment on this field and press     ↵ to send it. 

Users following the current resource can see the comment on their Home 
page, and reply you. 

<n> of <n> filters 
(only your user 
and Home pages) 

Click this field to expand the list of available filters. Then, you can check or 
uncheck options to filter in or out content in the activity stream, and click 
Done to apply the changes. 

You can click Check all to check all filters, and Uncheck all to uncheck all 
filters. 

Search Enter text here and press     ↵ to filter out in the activity stream any item 
that does not contain the entered text. 

Stream Activity 
The stream activity is a list of activity items. 

Each activity items consists of: 

o The image of the author, the user that performed the activity. 

o A description of the activity, with links to the resource pages of the resources 
involved in the activity. 

o The date and time of the activity. 

o A set of actions to interact with the activity item: 
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Stream 

Item Description 

Like Communicate to other users following the current resource that you like or 
approve of the activity. 

Reply Opens a text box. Write your reply there and press     ↵ to send it. 

Share Lets you share the target activity on your person page. 

When you click Share, a dialog box opens. You can optionally enter a 
Comment. Click Share to share the activity, or Cancel your action. 

Flag Flags the target activity as inappropriate, and sends it to the super users for 
review. 

Delete 
(author or 
super user) 

Deletes the target activity. 

When you reply to an activity item, ER/Studio Team Server displays your reply right after 
the target activity item. A reply consists of: 

o The image of the author, the user that wrote the reply. 

o The name of the author. 

o The text that the author wrote as a reply to the target activity item. 

o The date and time of the reply. 

o If you are the author of the reply, you can click Delete to remove your reply. 
ER/Studio Team Server asks you for confirmation before it deletes your reply. 

Stream Sidebar 
The sidebar in the right-hand side of the Stream page displays different content 
depending on the type of resource featured. See Resource Pages. 

In general, the sidebar shows a list of activity items somehow related to the current 
resource. 

See Also 
o Posting a Comment to a Resource 

o Following a Resource 

o Resource Pages 
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Discussions 

Discussions 
The Discussions subpage of glossary pages, term pages, ER object pages, and data 
source pages lets social users discuss any resource of one of those types. 

To start a new discussion, click New Discussion on the top-right corner. 

The list of discussion topic in the page provides the following columns: 

Item Description 

Expand/Collapse You can click the + or - button in this column to expand or collapse a 
discussion, respectively. 

Topic Title of the discussion. 

Started By User who started the discussion. 

When you expand a discussion, you can see the complete text of the first message of 
the discussion, followed by the replies to the discussions, and then by a text field where 
you can write your own reply. 

Each entry for a reply to the original discussion message displays: 

o The image of the author of the reply. 

o The username of the author of the reply. 

o The actual text of the reply. 

o The date when the user wrote the reply. 

o If you are the author of the reply, there is a Delete button on the right-hand side 
of the reply date that you can click to delete your reply. 

See Also 
o Discussing Resources 

o Working with Glossaries 

o Working with Terms 

o Working with ER Objects 

o Working with Data Sources 
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Followers 

Followers 
The Followers subpage of glossary pages, term pages, person pages, ER object pages, 
and data source pages lists the people that is following the current resource. 

See Also 
o Working with Glossaries 

o Working with Terms 

o Interacting with People 

o Working with ER Objects 

o Working with Data Sources 
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Glossary Pages 

Glossary Pages 
Glossary pages provide information about glossaries: activity, details, terms included, 
discussions about them, people who are following them, and child glossaries. They are 
only available for social users. 

To open a glossary page, follow a glossary link. There are several places where you can 
find glossary links, but if you are looking for a specific glossary, you can try the 
Glossaries search page. 

Glossary pages share a common header, and they also share a common sidebar. When 
you click the items in the sidebar, you get access to information pages about different 
aspects of the target glossary. 

Glossary Pages Header 

 

The glossary page header shows: 

o A glossary icon. 

o The name of the glossary. 

o The type of resource ("Glossary"). 

o If you are the owner of the glossary or an super user, you can click [Delete] to 
delete the glossary. 

On the top-right corner: 

o If you are the owner of the glossary or an super user, you can click New Term to 
add a new term to the glossary. 

o You can click + Follow to start following the current glossary, or Following to 
stop following it. See Following Resources. 

Glossary Pages Sidebar 
Glossary pages provide a sidebar with the following items: 
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Glossary Pages 

Item Description 

 
Stream 

Opens the activity stream of the current glossary. 

It displays entries, for example, when a term is associated with the current glossary. 

The sidebar shows: 

o Followers. A list of users that are following the current glossary. See 
the Followers subpage. 

o Terms. A list of terms associated with the current glossary. See the 
Terms subpage. 

o Children. A list of glossaries that are a child of the current glossary. 
See the Children subpage. 

 
Description 

Provides detailed information about the glossary. 

 
Terms 

Shows a list of terms that are associated with the current glossary. 

 
Discussions 

Opens the list of discussions about the current glossary. 

 
Followers 

Shows a list of users that are following the current glossary. 

 
Children 

Shows a list of glossaries that are a child of the current glossary. 

 
Permissions 

Opens the users and groups permissions tab for the glossary. 

See Also 
o Working with Glossaries 
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Glossary Description 

Glossary Description 
The Description subpage of glossary pages provides detailed information about a 
glossary. 

The page is divided in two columns: 

o The details column on the left-hand side. 

o The stewards column on the right-hand side. 

Details Column 
The details column provides the following fields: 

Item Description 

Author and Date On the top of the page, you can see the following text indicating the user 
who originally created the glossary, and the date when it was created: 

Created by <Author> on <Date> 

Edit On the right-hand side of the author and date information, there is an Edit 
button that you can click to enter the edition mode. 

In the edition mode, you can edit the glossary data, and click Save at the 
bottom of the page to save your changes, or Cancel to revert them. 

Name Name of the glossary. 

Parent Glossaries Parents of the glossary. 

Status Text describing the status of the glossary. 

Definition Detailed description of the glossary. 

Abbreviations List of abbreviations of the glossary. 

Aliases/Synonyms List of aliases and synonyms of the glossary. 

Additional Notes Custom information related to the business object that only you can see. 

Other users, including super users, cannot see the information in this field. 

Stewards Column 
The stewards column provides a list of Stewards, users with permission to edit the 
glossary. 

If you are on that list, you can click Edit there to add or remove people from the list. 
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Children 

Children 
 

The Children subpage of glossary pages list the glossaries that have the current 
glossary as a parent. 

You can use this page to add or remove children of the current glossary. 

The page is divided in two tabs: 

o The View tab displays a list with the glossaries that are a child of the current 
glossary. 

o The Manage tab lets you add or remove children from the current glossary. 
 

Manage Tab 
The content of the Manage tab is similar to the content of the Glossaries page. For 
example, it has a search box as well, and letters to navigate the matching glossaries. 

On the right-hand side of the glossary entries, you can click Add Child to make a 
glossary a child of the current glossary, or you can click Remove Child to remove the 
target glossary from the list of children of the current glossary. 

On the top of the list of glossaries, you can click Add All to make all the listed glossaries 
children of the current glossary, or you can click Remove All to remove all the listed 
glossaries from the list of children of the current glossary. 

 

See Also 
o Adding a Child to a Glossary 
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Term Pages 

Term Pages 
Term pages provide information about terms: activity, details, discussions about them, 
people who are following them, and related glossaries, ER objects and other terms. 
They are only available for social users. 

To open a term page, follow a term link. There are several places where you can find 
term links, but if you are looking for a specific term, you can try the Terms search page. 

Term pages share a common header, and they also share a common sidebar. When you 
click the items in the sidebar, you get access to information pages about different 
aspects of the target term. 

Term Pages Header 

 

The term page header shows: 

o A term icon. 

o The name of the term. 

o The type of resource ("Term"). 

o If you are the owner of the term or a super user, you can click [Delete] to delete 
the term. 

On the top-right corner, you can click + Follow to start following the current term, or 
Following to stop following it. See Following Resources. 

Term Pages Sidebar 
Term pages provide a sidebar with the following items: 
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Term Pages 

Item Description 

 
Stream 

Opens the activity stream of the current term. 

It displays entries, for example, when a term is related to a glossary. 

The sidebar shows: 

o Followers. A list of users that are following the current term. See 
the Followers subpage. 

o Related Glossaries. A list of glossaries that are related to the 
current term. See the Related Glossaries subpage. 

o Related Terms. A list of terms related to the current term. See 
the Related Terms subpage. 

o Related ER Objects. A list of ER object related to the current 
term. See the Related ER Objects subpage. 

 
Description 

Provides detailed information about the term. 

 
Discussions 

Opens the list of discussions about the current term. 

 
Followers 

Shows a list of users that are following the current term. 

 
Related 
Glossaries 

Shows a list of glossaries that are related to the current term. 

 
Related Terms 

Shows a list of terms that are related to the current term. 

 
Related ER 
Objects 

Shows a list of ER Objects that are related to the current term. 

See Also 
o Working with Terms 

o Working with Glossaries 

o Working with ER Objects 
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Term Description 

Term Description 
The Description subpage of term pages provides detailed information about a term. 

The page is divided in two columns: 

o The details column on the left-hand side. 

o The stewards column on the right-hand side. 

Details Column 
The details column provides the following fields: 

Item Description 

Author and Date On the top of the page, you can see the following text indicating the user 
who originally created the term, and the date when it was created: 

Created by <Author> on <Date> 

Edit On the right-hand side of the author and date information, there is an Edit 
button that you can click to enter the edition mode. 

In the edition mode, you can edit the term data, and click Save at the 
bottom of the page to save your changes, or Cancel to revert them. 

Name Name of the term. 

Status Text describing the status of the term. 

Definition Detailed description of the term. 

Abbreviations List of abbreviations of the term. 

Aliases/Synonyms List of aliases and synonyms of the term. 

Adidtional Notes Additional information about the business object. 

Stewards Column 
The stewards column provides a list of Stewards, users with permission to edit the term. 

If you are on that list, you can click Edit there to add or remove people from the list. 

See Also 
o Working with Terms 
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Related Glossaries 

Related Glossaries 
The Related Glossaries subpage of term pages lists the glossaries related to the term. 

If you are a steward of the term, you can use this page to relate or unrelate glossaries to 
the term. With the exception of Child Glossaries that are inherited and cannot be 
unrelated. 

The page is divided in two tabs: 

o The View tab displays a list with the glossaries related to the term. 

o The Relate tab lets you relate and unrelate glossaries to the term. 
 

Relate Tab 
The content of the Relate tab is similar to the content of the Glossaries page. For 
example, it has a search box, and letters to navigate the matching glossaries. 

On the right-hand side of the glossary entries, you can click Relate to relate a glossary to 
the term, or you can click Unrelate to unrelate the target glossary from the current term. 

On the top of the list of glossaries, you can click Relate All to relate all the listed 
glossaries to the current term, or you can click Unrelate All to unrelate all the listed 
glossaries from the current term.  

 

See Also 
o Associating a Term with a Glossary 

o Terms page 

o Working with Terms 

o Working with Glossaries 
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Related Terms 

Related Terms 
The Related Terms subpage (this subpage is called Terms in glossary pages), term 
pages, and ER object pages lists the terms related to/from the current resource. 

You can use this page to relate or unrelate terms to the current term. 

The page is divided in two tabs: 

o The View tab displays a list with the terms related to the current resource. 

o In ER object pages only, the Match tab lets you match and unmatch terms to the 
current ER object. 

o The Relate tab lets you relate and unrelate terms to the current resource. 

View Tab 
The content of the View Tab is a list of related Terms for the resource that you are 
currently viewing. In ER Objects, there will be all the Terms that are related or matched 
to the Term. In the Glossary subpage there will be related Terms to the Glossary or to 
the Parent Glossary. 

 

 

Match Tab 
The content of the Match tab is similar to the content of the Terms page. For example, 
it has a search box, and letters to navigate the matching terms. 

You can click the Refresh button, right below the list of letters, to perform an automatic 
match against existing terms. ER/Studio Team Server automatically matches any term 
contained by the current ER object. 

On the right-hand side of the term entries, you can click Unmatch to unmatch matching 
terms, or click Re-Match to match terms that you manually unmatched. 
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Related Terms 

Relate Tab 
The content of the Relate tab is similar to the content of the Terms page. For example, 
it has a search box, and letters to navigate the matching terms. 

On the right-hand side of the term entries, you can click Relate to relate a term to the 
current resource, or you can click Unrelate to unrelate the target term from the current 
resource. 

On the top of the list of terms, you can click Relate All to relate all the listed terms to 
the current resource, or you can click Unrelate All to unrelate all the listed terms from 
the current resource. 

On the Glossary subpage, any Terms that are listed from a Parent Glossary will also be 
highlighted with the words (Inherited from Parent Glossary). It is not possible to unrelate 
Terms that have been inherited from a Parent Glossary.  

 

See Also 
o Adding a Term to a Glossary 

o Associating a Term with Another Term 

o Associating an ER Object with a Term 

o Matching an ER Object with Terms 
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Related ER Objects 

Related ER Objects 
The Related ER Objects subpage of term pages lists the ER objects that are either 
related to the current term, or that contain the term in their name or other property 
values. 

 
You can use the related ER Objects page to relate or unrelate and match or unmatch 
ER objects to the current term. 

The page is divided in three tabs: 

o The View Tab. 

o The Found In tab lets you match and unmatch ER objects to the current term. 

o The Relate tab lets you relate and unrelate ER objects to the current term. 

View Tab 
displays a list of related and matching ER objects. The list shows the related ER objects 
first, and then the matching ER objects. 
 

Found In Tab 
The content of the Found In tab is similar to the content of the ER Objects page. For 
example, it has a search box as well, and letters to navigate the matching ER objects. 

You can click the Refresh button, right below the list of letters, to perform an automatic 
match against existing ER objects. ER/Studio Team Server automatically matches any ER 
object containing the current term. 

On the right-hand side of the ER object entries, you can click Unmatch to unmatch 
matching ER objects, or click Re-Match to match ER objects that you manually 
unmatched. 
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Related ER Objects 

Relate Tab 
The content of the Relate tab is similar to the content of the ER Objects page as well, 
and it also has a search box and letters to navigate the matching ER objects. 

On the right-hand side of the ER object entries, you can click Relate to relate a ER 
object to the current term, or you can click Unrelate to unrelate the target ER object 
from the current term. 

On the top of the list of ER objects, you can click Relate All to relate all the listed ER 
objects to the current term, or you can click Unrelate All to unrelate all the listed ER 
objects from the current term. 

See Also 
o Associating a Term with an ER Object 

o Matching a Term with ER Objects 
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Person Pages 

Person Pages 
Person pages provide information about users: activity, personal data, people they are 
following, people who are following them, and more. They are only available for social 
users. 

To open a person page, follow a user link. There are several places where you can find 
user links, but if you are looking for a specific user, you can try the People search page. 

Person pages share a common header, and they also share a common sidebar. When 
you click the items in the sidebar, you get access to information pages about different 
aspects of the target user. 

Person Pages Header 

 

The person page header shows: 

o An image of the user. A default image is shown if the user does not upload an 
image. 

o The name of the user (not the username). 

o The job title of the user. 

On the top-right corner: 

o If you are viewing your own person page, you can click Edit to open the 
Configure Profile page. 

o Otherwise, you can click + Follow to start following the current user, or 
Following to stop following. See Following Resources. 

Person Pages Sidebar 
Person pages provide a sidebar with the following items: 
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Person Pages 

Item Description 

 
Stream 

Opens the activity stream of the current user. 

It displays entries, for example, when the current user comments on a model 
metadata, glossary terms, and domain pages. 

 
Description 

Provides detailed information about the user. 

 
Followers 

Shows a list of users that are following the current user. 

 
Following 

Shows a list of users that the current user is following. 

See Also 
o Interacting with People 
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Configure Profile 

Configure Profile 
 

Home | click your name or image | Edit (social users) 

From the Configure Profile page you can configure your user profile to share some of 
your personal data with other ER/Studio Team Server social users. 

You can edit any of the following fields and click Save Changes at the bottom of the 
page to save your changes.  
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Configure Profile 

Item Description 

Photo Click Browse to open a file manager dialog where you can select a local image 
file. After you select an image file, click Upload to upload the image to 
ER/Studio Team Server and use it as your user image. 

Note: Under the Browse button there is a description of the 
format and size limitations that ER/Studio Team Server enforces 
on user images. If your image does not fit those limitations, 
uploading your image fails. 

Title Your job title. For example, "Quality Assurance Engineer" or "Technical Writer". 

First Name Your first name. For example, "Jane" or "John". 

Job 
Description 

A brief description of your job responsibilities. 

Phone Your phone number. 

Email Your email address. 

Stream 
Moderation 

You can toggle the following options: 

o "Allow others to post to your stream". Check this option so that 
other users can post comments associated with your user. 

o "Allow others to comment on activity in your stream". Check this 
option so that other users can reply to items in your activity 
stream. 

See Also 
o Configuring Your User Profile 

o Stream 
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Following 

Following 

 
The Following subpage of person pages lists the resources (glossaries, terms, people, 
ER objects, data sources) that the user is following. 

See Also 
o Interacting with People 
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User Description 

User Description 

 
The Description subpage of person pages provides detailed information about a user. 

The page provides the following fields: 

Item Description 

Title User display name. 

ER/Studio Team Server displays the user display name in the header of person 
pages, below the user name. 

Name First and last names of the user. 

Job 
Description 

Detailed description of the user's job. 

Phone Telephone number where you can reach the user. 

Email Email address of the user. 

See Also 
o Interacting with People 
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ER Object Pages 

ER Object Pages 
ER Object pages provide detailed information about specific ER objects, in addition to 
links to related ER objects. You can follow those links to browse the Reporting 
Repository. 

You can access ER object pages by browsing and searching ER/Studio Team Server. 

ER Object pages share a common header, and they also share a common sidebar. When 
you click the items in the sidebar, you get access to information pages about various 
aspects of the target ER object. 

ER Object Pages Header 

 

The ER object page header shows: 

o An image representing the ER object. A default image is shown if the ER object 
cannot be represented by an image. 

o The name of the ER object. 

o The type of the ER object. 

o Breadcrumbs with the ER objects that are above the current ER object in the ER 
object hierarchy. Here you can click the parents of the current ER object to 
access their ER object pages. 

o The Linked Term reference or option to create a Linked Term. 

On the top-right corner: 

o If you are a social user, you can click + Follow to start following the current ER 
object, or Following to stop following it. See Following Resources. 

o If you are a non-social user, you can click to start watching the current ER 
object for updates, or to stop watching it. See Watching ER Objects for New 
Comments. 

ER Object Pages Sidebar 
The sidebar in ER object pages provides different items depending on your user type: 
social or non-social. 
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ER Object Pages 

Sidebar for Social Users 

When you are a social user, ER object pages provide a sidebar with the following items, 
depending on the ER object type: 

Item Description 

 
Stream 

Opens the activity stream of the current ER object. 

 
Description 

Provides detailed information about the ER object, with links to 
related ER objects. This page looks different depending on the type 
of the current ER object. 

 
Discussions 

Opens the list of discussions about the current ER object. 

 
Followers 

Shows a list of users that are following the current ER object. 

 
Related Terms 

Shows a list of terms that are associated with the current ER object. 

 
Related Data Sources 

Shows a list of data sources that are associated with the current ER 
object. 

 
Alerts 
(only security properties 
and attachments) 

Lets you configure conditions that raise alerts about sensitive data. 

 
Permissions 

Opens the users and groups permissions tab for the current diagram, 
model or submodel. 

Note: The Stream, Discussions, and Followers entries in the sidebar of an ER object 
page are disabled until you perform some social interaction with the target ER object. 
To enable them you can, for example, start following the target ER object. 

Sidebar for Non-Social Users 

When you are a non-social user, ER object pages provide a sidebar with a single item: 
Description. 

See Also 
o Working with ER Objects 
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Alerts 

Alerts 

 
Alerts subpage provides detailed information about the conditions alerts that a Security 
Property or an Attachment has. If an alert condition matches an ER object, ER/Studio 
Team Server displays on the header of an ER object page, the alert message and icon 
defined in the alert condition. 

 
You can access the Alerts subpage by clicking the Alerts Icon at the common sidebar 
from a Security Property or Attachment page. 

This page provides an action on top, New Condition. You can click this action to add a 
new alert condition entry to the page. 

 
Super users can edit and delete any alert condition, however authenticated users can 
only edit and delete those alert conditions that they create. 

Alert Condition Entries 
Each alert condition entry in the page provides the following fields: 
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Alerts 

Item Description 

Show Alert 
for 
Matching 

Here you can define the condition that should result in showing the target alert on 
any matching ER object. You may choose any of the following values: 

o Bound Object. Show the target alert for any object bound to the 
current security property or attachment. 

o Value. Show the target alert for any object bound to the current 
security property or attachment where the security property or 
attachment has the specified value. You can specify the target value 
on the text input field on the right-hand side of Value. 

Alert Level The level of the alert, which determines which icons ER/Studio Team Server 
displays along with the defined Notification Text. You may choose any of the 
following values: 

o Info. 

o Notice. 
The following image shows the header of an ER object with one alert of each type 
and a Notification Text equal to the name of the chosen Alert Level. 

 

Notificatio
n Text 

Text of the alert. 

ER/Studio Team Server displays this text on the header of matching ER objects, on 
the right-hand side of the icon representing the Alert Level. 

Delete 
Condition 
(only super 
users and 
alert 
condition 
author) 

Deletes the target condition. 

Note:ER/Studio Team Server saves changes to field values as fields lose focus. 
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ER Object Description 

ER Object Description 
The Description subpage of ER object pages provides detailed information about an ER 
object. 

The content of the page varies from one ER object type to another. However, when you 
are a non-social user, all of them provide the following two sections at the end of the 
page: 

Item Description 

Labels Lets you view and manage the current ER object labels. 

Comments Lets you view the comments to the current ER object. You can add, edit or delete 
your own comments, or any comment if you are an super user. 

This is a list of available ER object description pages: 

o ER Object description pages for ER/Studio Data Architect object types:  

 Attachment 

 Attachment Type 

 Attribute/Column 

 Bound Attachment 

 Bound Data Movement Rule 

 Bound Security 

 Data Lineage Column 

 Data Lineage Source/Target 

 Data Lineage Table 

 Data Movement Rule 

 Default 

 Diagram 

 Dictionary 

 DL Transformation 

 Domain 

 Entity/Table 

 Key/Index 

 Lineage Data Flow 
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ER Object Description 

 Lineage Data Stream 

 Model 

 Reference Value 

 Relationship 

 Security Property 

 Security Type 

 Submodel 

 User Datatype 

 View 

 View Column 

o ER Object description pages for ER/Studio Business Architect object types:  

 BM_Annotation 

 BM_Assignment 

 BM_Association 

 BM_BusinessAttribute 

 BM_BusinessElement 

 BM_BusinessEntity 

 BM_BusinessUnit 

 BM_DataElement 

 BM_DataObject 

 BM_DataSource 

 BM_DataStore 

 BM_Diagram 

 BM_Domain 

 BM_Event 

 BM_Gateway 

 BM_Group 

 BM_Lane 

 BM_Link 
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ER Object Description 

 BM_Model 

 BM_Message_Flow 

 BM_PDiagram 

 BM_Pool 

 BM_Process 

 BM_Project 

 BM_Property 

 BM_PProperty 

 BM_ReferenceColumn 

 BM_ReferenceEntity 

 BM_Relationship 

 BM_Rule 

 BM_Sequence_Flow 

 BM_Steward 

 BM_SubjectArea 

 BM_Task 

 BM_Trigger 

 BM_Usage 

 BM_Workspace 

See Also 
o Working with ER Objects 
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Data Source Pages 

Data Source Pages 
Data source pages provide information about data sources: activity, details, discussions 
about them, people who are following them, and related ER models. They are only 
available for social users. 

To open a data source page, follow a data source link. There are several places where 
you can find data source links, but if you are looking for a specific data source, you can 
try the Data Sources search page. 

Data source pages share a common header, and they also share a common sidebar. 
When you click the items in the sidebar, you get access to information pages about 
different aspects of the target data source. 

Data Source Pages Header 

 

The data source page header shows: 

o A data source icon. 

o The name of the data source. 

o The type of resource ("Data Source"). 

o If you are the owner of the data source or a super user, you can click [Delete] to 
delete the data source. 

On the upper-right corner, you can click + Follow to start following the current data 
source, or Following to stop following it. See Following Resources. 

Data Source Pages Sidebar 
Data source pages provide a sidebar with the following items: 

 

Note: Related ER Models is available if there is an ER/Studio Team Server License 
registered. Related Login Credentials and Monitoring are available if there is a 
DBArtisan Team Sever License registered 
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Data Source Pages 

Item Description 

 
Stream 

Opens the activity stream of the current data source. 

Displays entries, for example, when a data source is related to an ER 
model. 

The sidebar shows: 

o Followers. A list of users that are following the current data 
source. See the Followers subpage. 

 
Description 

Provides detailed information about the data source. 

 
Discussions 

Opens the list of discussions about the current data source. 

 
Followers 

Shows a list of users that are following the current data source. 

 
Related ER Models 

Shows a list of ER models that are related to the current data source. 

 
Related Login 
Credentials 

Shows a list of Login Credentials that are related to the current data 
source. 

 
Permissions 

Opens the users and groups permissions tab for the data source. 

See Also 
o Working with Data Sources 
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Data Source Description 

Data Source Description 
 

The Description subpage of data source pages provides detailed information about a 
data source. 

The page is divided in two columns: 

o The details column on the left-hand side. 

o The stewards column on the right-hand side.  

o  

Details Column 
The details column provides the following fields: 
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Data Source Description 

Item Description 

Author and Date On the top of the page, you can see the following text indicating the 
user who originally created the term, and the date when it was 
created: 

Created by <Author> on <Date> 

Edit On the right-hand side of the author and date information, there is an 
Edit button that you can click to enter the edition mode. 

In the edition mode, you can edit the term data, and click Save at the 
bottom of the page to save your changes, or Cancel to revert them. 

Name Name of the data source. 

Definition Detailed description of the data source. 

Production Level Production Level of the data source. 

Location Location of the data source. 

Application Affinity Application Affinity of the data source. 

Status Status of the data source. 

Abbreviations List of abbreviations of the data source. 

Aliases/Synonyms List of aliases and synonyms of the data source. 

Additional Notes Custom information related to the data source that only you can see. 

Other users, including super users, cannot see the information in this 
field. 

Type Type of database management system (DBMS) of the data source. 

The following DBMS are supported: DB2 LUW, DB2 z/OS, InterBase, 
Firebird, JDBC, MySQL, ODBC, Oracle, SQL Azure, SQL Server, 
Sybase, Sybase IQ. 

<Database 
Management System 
Fields> 

Depending on the Type of data source, ER/Studio Team Server 
displays a different set of fields between the Type and the Custom 
Properties fields. See Data Source Fields for a Specific Database 
Management System. 

Custom Properties Custom properties of the data source. For each property you can see 
a property name and an associated property value. 

Stewards Column 
The stewards column provides a list of Stewards, users with permission to edit the data 
source. 
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Data Source Description 

If you are on that list, you can click Edit there to add or remove people from the list. 

See Also 
o Working with Data Sources 

o Data Source Fields for a Specific Database Management System 
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Related ER Models 

Related ER Models 

 
The Related ER Models subpage of Data Sources lists the ER Models that are either 
related to the current Data Source, or that can be related to the Data Source. 

You can use the Related ER Models page to relate or unrelate ER Models to the current 
Data Source. 

The page is divided in two tabs: 

View Tab 
The View Tab displays a list of related ER Models. The list shows the ER Models currently 
related to the selected Data Source. From here you can relate and unrelate ER Models 
to the current Data Source. 

 

Relate Tab 
The Relate Tab allows you to relate and unrelate ER Models to the current Data Source. 

The Relate tab contains a list of Data Models that can be related to the Data Source. 
The list is arranged with alphabetical navigation and contains a search box. 

On the right side of the ER object entries, you can click Relate to relate a ER object to 
the current Data Source, or you can click Unrelate to unrelate the target ER Model from 
the current Data Source. 

 

See Also 
o Data Source Pages 

o ER Objects 

o Working with Data Sources 
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Related Login Credentials 

Related Login Credentials 

 
The Related Login Credentials subpage of Data Sources lists the Login Credentials 
that are either related to the current Data Source, or that can be related to the Data 
Source. 

You can use the Related Login Credentials page to relate or unrelate Login Credentials 
to the current Data Source. 

The page is divided in two tabs: 

View Tab 
The View Tab displays a list of related Login Credentials. The list shows the Login 
Credentials currently related to the selected Data Source. From here you can test 
connection to the current Data Source with each related Login Credential . 

 

Relate Tab 
The Relate Tab allows you to relate and unrelate Login Credentials to the current Data 
Source. 

The Relate tab contains a list of Login Credentials that can be related to the Data 
Source. The list is arranged with alphabetical navigation and contains a search box. 

On the right side of the Login Credentials entries, you can click Relate to relate a Login 
Credential to the current Data Source, or you can click Unrelate to unrelate the target 
Login Credential from the current Data Source. 

 

See Also 
o Data Source Pages 
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App Pages 

App Pages 
App pages provide information about apps: activity, details, server code, discussions 
about them, people who are following them and permissions. They are only available for 
social users. 

To open an app page, follow a app link. There are several places where you can find app 
links, but if you are looking for a specific app, you can try the Apps search page. 

App pages share a common header, and they also share a common sidebar. When you 
click the items in the sidebar, you get access to information pages about different 
aspects of the target application. 

App Pages Header 

 

The app page header shows: 

o A app icon. 

o The name of the app. 

o The type of resource ("App"). 

o If you are the owner of the application or an super user, you can click [Delete] to 
delete the app. 

On the top-right corner: 

o You can click + Follow to start following the current app, or Following to stop 
following it. See Following Resources. 

App Pages Sidebar 
App pages provide a sidebar with the following items: 
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App Pages 

Item Description 

 
Stream 

Opens the activity stream of the current app. 

It displays entries, for example, like who created the application. 

The sidebar shows the Followers. A list of users that are following the current 
application. 

See the Followers subpage. 

 
Description 

Provides detailed information about the app. 

 
Server 
Code 

Shows the page where you can develop and test your application. 

 
Discussions 

Opens the list of discussions about the current application. 

 
Followers 

Shows a list of users that are following the current app. 

 
Permissions 

Opens the users and groups permissions tab for the application. 

See Also 
o Server Code Examples 
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App Description 

App Description 
The Description subpage of app pages provides detailed information about an 
application. 

The page is divided in two columns: 

o The details column on the left-hand side. 

o The stewards column on the right-hand side. 

Details Column 
The details column provides the following fields: 

Item Description 

Author and Date On the top of the page, you can see the following text indicating the user 
who originally created the app, and the date when it was created: 

Created by <Author> on <Date> 

Edit On the right-hand side of the author and date information, there is an Edit 
button that you can click to enter the edition mode. 

In the edition mode, you can edit the app data, and click Save at the 
bottom of the page to save your changes, or Cancel to revert them. 

Name Name of the application. 

Status Text describing the status of the app. 

Definition Detailed description of the app. 

Abbreviations List of abbreviations of the application. 

Aliases/Synonyms List of aliases and synonyms of the app. 

Aditional Notes Additional information about the app. 

Stewards Column 
The stewards column provides a list of Stewards, users with permission to edit the data 
source. 

If you are on that list, you can click Edit there to add or remove people from the list. 

See Also 
o Working with Apps 
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Server Code 

Server Code 
The Server Code menu on the Apps page is where you add the script files to run in your 
app. 

To create a new Server Code: 

1. Click the New File button. 

2. In the New File window that appears, choose a name for your Server Code File 
and click Save. 

3. Highlight the New File you have created by clicking the name of your new file. 

4. To save any script that you enter in to the Server Code window, choose the Save 
button. 

The following script is a function to add the Steward of your choosing to all terms. 
 
function addStewardToAllTerms(stewardId) { 
var added = 0; 
var error = 0; 
var already = 0; 
var terms = TeamServer.terms.list(); 
for ( var i=0; i<terms.size(); i++ ) { 
var term = terms.get(i); 
if ( term.stewards.get(stewardId) === null ) { 
var result = term.stewards.add(stewardId); 
if (result.result == "OK") { 
added++; 
} 
else { 
error++; 
println(result.message); 
} 
} 
else { 
already++; 
} 
} 
println( "Add steward " + stewardId + " to all terms: added " + added + ", 
already steward " + already + ", errors " + error); 
} 
addStewardToAllTerms("11"); 
 

It is possible to copy and paste this script in to your server code window. Changing the 
final line to instruct the function to work with your required steward. The example above 
uses '11', you may wish to change this to addStewardToAllTerms("1"); for Admin. 

 

See Also 
o Server Code Examples 
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Server Code Examples 

Server Code Examples 
Creating your own apps within ER/Studio Team Server allows you to add functions that 
are specific to your needs. 

You can work with: 

o Glossaries 

o Stewards of Glossaries or Terms 

o Terms 

o Relationships of Terms and Glossaries  

 Note: For example TeamServer.terms.get(123).terms.list() 
returns a list of all of the terms related with the term of ID=123 

Delete All Terms 
 
function deleteTerms() { 
   var terms = TeamServer.terms.list(); 
   var count = 0; 
   for (var i=0; i<terms.size(); i++) { 
       var term = terms.get(i) 
       TeamServer.terms.destroy(term.id) 
       count++; 
   } 
   println(count + " terms deleted"); 
} 
 
deleteTerms(); 
 

Add Steward to All Terms 
 
function addStewardToAllTerms(stewardId) { 
var added = 0; 
var error = 0; 
var already = 0; 
var terms = TeamServer.terms.list(); 
for ( var i=0; i<terms.size(); i++ ) { 
var term = terms.get(i); 
if ( term.stewards.get(stewardId) === null ) { 
var result = term.stewards.add(stewardId); 
if (result.result == "OK") { 
added++; 
} 
else { 
error++; 
println(result.message); 
} 
} 
else { 
already++; 
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Server Code Examples 

} 
} 
println( "Add steward " + stewardId + " to all terms: added " + added + ", 
already steward " + already + ", errors " + error); 
} 
addStewardToAllTerms("11"); 
 

See Also 
o Server Code 

o Apps 
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Group Pages 

Group Pages 
Groups pages provide information about groups: activity, details, discussions about 
them, people who are following them, and included resources. 

To open a group page, follow a group link. 

Group pages share a common header, and they also share a common sidebar. When 
you click the items in the sidebar, you get access to information pages about different 
aspects of the target group. 

Group Pages Header 

 

The group page header shows: 

o A group icon. 

o The name of the group. 

o The type of resource ("Group"). 

o If you are the owner of the group or a super user, you can click [Delete] to delete 
the group. 

On the top-right corner, you can click + Follow to start following the current group, or 
Following to stop following it. See Following Resources. 

Group Pages Sidebar 
Group pages provide a sidebar with the following items: 
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Group Pages 

Item Description 

 
Stream 

Opens the activity stream of the current Group. 

The sidebar shows Followers. A list of users that are following the current 
Group. See the Followers subpage. 

 
Description 

Provides detailed information about the group. 

 
Discussions 

Opens the list of discussions about the current group. 

 
Followers 

Shows a list of users that are following the current group. 

 
Included Data 
Sources 

Shows the list of Data Sources that are included into the current group. 

 
Permissions 

Opens the users and groups permissions tab for the group. 

See Also 
o Working with Groups 

o Working with Data Sources 
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Group Description 

Group Description 
 

The Description subpage of group pages provides detailed information about a group. 

The page is divided in two columns: 

o The details column on the left-hand side. 

o The stewards column on the right-hand side. 

o   

Details Column 
The details column provides the following fields: 
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Group Description 

Item Description 

Author and Date On the top of the page, you can see the following text indicating the user 
who originally created the term, and the date when it was created: 

Created by <Author> on <Date> 

Edit On the right-hand side of the author and date information, there is an Edit 
button that you can click to enter the edition mode. 

In the edition mode, you can edit the term data, and click Save at the 
bottom of the page to save your changes, or Cancel to revert them. 

Name Name of the term. 

Status Text describing the status of the term. 

Definition Detailed description of the term. 

Abbreviations List of abbreviations of the term. 

Aliases/Synonyms List of aliases and synonyms of the term. 

Additional Notes Additional information about the business object. 

Stewards Column 
The stewards column provides a list of Stewards, users with permission to edit the data 
source. 

If you are on that list, you can click Edit there to add or remove people from the list. 

See Also 
o Working with Data Sources 

o Data Source Fields for a Specific Database Management System 
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Login Page 

Login Page 
The Login page lets you enter your user credentials to access an ER/Studio Team Server 
installation. 

You can only open this page if you are not currently logged in to ER/Studio Team 
Server. To access this page, open http://teamserver.example.com/Login in a web 
browser (replace "http://teamserver.example.com" by the actual URL of your ER/Studio 
Team Server installation). 

This page provides the following items: 

Item Description 

Username Your username to access ER/Studio Team Server. 

Password Your password. 

Remember 
me 

Check this option to make ER/Studio Team Server remember you for a week, so 
that you do not need to enter your user credentials again during that period. 

Log In Click this button to access ER/Studio Team Server. 

See Also 
o Connecting to ER/Studio Team Server 
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Navigation Menu 

Navigation Menu 
The main navigation menu provides items to give you access to the main features of 
ER/Studio Team Server. 

The availability of the items in the navigation menu changes depending on your license 
type: 

o Basic Navigation Menu 

o DBArtisan Navigation Menu 

o ER/Studio Navigation Menu 

See Also 
o Overview of User Experiences 
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Navigation Menu (Basic) 

Navigation Menu (Basic) 
This are the available features on the navigation menu when you log as super user with 
no license registered: 

 

The navigation menu provides the following items in this situation: 

Item Description 

Home See recent activity of ER objects and people that your are following. 

People Search for users. 

Data Sources Search and manage Data Sources. 

See Also 
o Navigation Menu (DBArtisan) 

o Navigation Menu (ER/Studio) 

o Overview of User Experiences 

 
Embarcadero Technologies  95 

http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Overview_of_User_Roles%23Super_User
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Home_(social)
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/People
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Data_Sources
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Navigation_Menu_(DBArtisan)
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Navigation_Menu_(ER/Studio)
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Overview_of_User_Experiences


Navigation Menu (DBArtisan) 

Navigation Menu (DBArtisan) 
This are the available features on the navigation menu when you have a DBArtisan 
Team Server license registered: 

 

The navigation menu for DBArtisan users provides the following items: 

Item Description 

Home See recent activity of ER objects and people that your are following. 

People Search for users. 

Data 
Sources 

Search and manage Data Sources. Including Login Credentials and Monitoring 
capability. 

See Also 
o Navigation Menu (Basic) 

o Navigation Menu (ER/Studio) 

o Overview of User Experiences 
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Navigation Menu (ER/Studio) 

Navigation Menu (ER/Studio) 
This are the available features on the navigation menu when you have an ER/Studio 
Team Server license registered: 

 

The navigation menu for ER/Studio users provides the following items: 

Item Description 

Home See recent activity of ER objects and people that your are following. 

Glossaries Search for glossaries. 

Terms Search for terms. 

People Search for users. 

ER Objects Search for ER objects of the Reporting Repository. 

ER Tools Lets you navigate to the business and technical reports and create custom reports. 
From here you can also access your favorite and shared searches and reports. 

Data 
Sources 

Search and manage Data Sources, including the capability of relating models. 

See Also 
o Navigation Menu (Basic) 

o Navigation Menu (DBArtisan) 

o Overview of User Experiences 
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Report Pages 

Report Pages 
Report pages provide the results of a report in HTML format. 

At the top of the page you can access the following actions: 

Action Description 

View as pdf Downloads the report as a PDF file. 

View as xls Downloads the report as an XLS file, that is, a Microsoft Excel spreadsheet. 

Tip: To print the HTML version of the report, use the printing function of your web 
browser. In most web browsers, you can press Ctrl + P to open the printing function. 

Report Pages 
This is a list of available report pages: 

o Reports that super users can open from the Activity page:  

 Login Activity Details 

 Updated Object Details 

 Connection Activity Details 
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Connection Activity Details 

Connection Activity Details 
My Settings > Activity | click a bar in the Connection Activity graphic (super users) 

In this report you can see a list of connections established during a specific time frame. 

The report contains the following columns: 

Column Description 

User Name The name of the user that connected. 

Host The hostname of the machine from which the user connected. 

IP The IP address of the access point from which the user connected. 

Login Time The date when the user session started. 

Logout Time The date when the user session ended. 

Connection Type The connection type that the user consumed. 

See Also 
o Activity 

o Login Activity Details 

o Updated Object Details 
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Login Activity Details 

Login Activity Details 
My Settings > Activity | click a bar in the Login Activity graphic (super users) 

In this report you can see the login activity during a specific time frame. 

The report contains the following columns: 

Column Description 

User Name The name of the user that logged in. 

User Description The description of the user that logged in. 

Login Time The date when the user session started. 

Connection Type The connection type that the user consumed. 

See Also 
o Activity 

o Connection Activity Details 

o Updated Object Details 
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Updated Object Details 

Updated Object Details 
My Settings > Activity | click a bar in the Updated Objects graphic (super users) 

In this report you can see a list of update events that affected ER objects of a specific ER 
object type during a specific time frame. 

The report contains the following columns: 

Column Description 

Event Date The date when the update event took place. 

Parent 
Name 

The name of the parent of the updated ER object. You can click the parent name 
to access its ER object page. 

Name The name of the updated ER object. You can click the ER object name to access 
its ER object page. 

User Name The name of the ER/Studio Team Server user that modified the ER object. 

Operation The type of operation applied to the ER object. 

See Also 
o Activity 

o Connection Activity Details 

o Login Activity Details 
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Search Pages 

Search Pages 
Search pages let you search for a certain type of resources within the Reporting 
Repository: glossaries, people, ER objects, etc. 

Search pages are only available for social users, and you can open them from the 
navigation menu. 

Although some of them provide additional buttons in the body, all search pages have 
the same body and sidebar. The search filters may change slightly depending on which 
resource you are viewing. 

For a list of search pages, see the following index. 

Search Page Body 
The body of every search page contains a header with at least the following items: 

o The title of the search page. 

o A search box to search for resources of the type of the search page. Global 
searches do not provide this field, as you can use the global search box instead. 

o A list with all the letters in the alphabet. You can click any of the letters to show in 
the search results only those resources beginning with the chosen letter. At the 
beginning of the list, you can click the All option to disable the filter.  

 
 

Below the header there is the list of search results. Each search result provides at least 
the following information: 

o An icon representing the resource. 

o The name of the matching resource. You can click the name to open a page with 
details about the matching resource. 

o On the right-hand side of each search result, there is an action area which might 
show any of the following:  

 A + Follow button to start following the target matching resource. 

 A Following button that indicates that you are following the matching 
resource. You can click this button to stop following the target matching 
resource. 

 Nothing, if you cannot follow the matching resource. For example, you 
cannot follow yourself, so your user entry when searching for people does 
not show any button. 

 
Embarcadero Technologies  102 

http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Overview_of_the_ER/Studio_Team_Server_Architecture
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Overview_of_the_ER/Studio_Team_Server_Architecture
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Overview_of_User_Experiences%23Social_Users
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Navigation_Menu%23Social_Navigation_Menu
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/People


Search Pages 

 

In most search pages, under the name of the matching resource additional information 
about the resource is provided. 

 

When the number of search results is greater than the default number of search results 
to display on each search page, a pagination bar is displayed both before and after the 
list of search results: 

 

This pagination bar provides the following items: 

Item Description 

< previous 
page 

Loads the previous page of search results. 

1 2 3 ... In the center of the pagination bar, there is a list of page numbers, a number for 
each page of search results (until you reach a certain limit). 

You can click any number to load the target page of search results. For example, 
click 3 to load the third page of search results. 

next page > Loads the next page of search results. 

items per 
page 

Choose from the combo box the number of results per page that you want to see: 
10, 20, 50, or 100. 

Search Page Sidebar 
The sidebar of search pages shows different content depending on whether you are 
performing a global search or searching for a specific type of items. 
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Search Pages 

 

Global Search Page Sidebar 

When you perform a global search, the left-hand sidebar provides two different sections: 
Search In and Filter By. 

Under Search In there is a list of resource fields or field groups that you can search 
depending on the resource you are viewing: 

o Name 

o Aliases/Synonyms 

o Definition 

o Notes (searching includes both notes and additional notes) 

o General Properties 

o Custom Attributes 

Note: For more effective searching, not all fields will be available to search for every 
resource. For example, when searching People, Terms, Glossaries or Data Sources the 
fields for Notes or General Properties are not included. When searching for People or 
ER Objects the search field for Aliases/Synonyms is not available. 

You can check or uncheck any entry in the list. When you toggle an entry, ER/Studio 
Team Server repeats the search, and searches only those entries that are checked in the 
list. 
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Search Pages 

Under Filter By there is a list of the types of resources that match the current search. 
You can click a resource type so that the search results include only resources of the 
selected type. 

The first entry in the filter list, Everything, is selected by default when you start a global 
search, and does not filter the search results by resource type. 

The ER Objects resource type, when listed under Filter By, has an icon on the right-
hand side: . You can click that icon to display a list of subtypes (types of ER objects), 
and you can click any subtype to filter the search results by that type of ER object. 

 

Resource-specific Search Page Sidebar 

The sidebar of search pages for specific types of resources always contains the following 
two entries: 

o All <Search Page Name>. Lets you search for any resource of the type of the 
search page. 

o My <Search Page Name>. Lets you search only for resources of the type of the 
search page that you are following. 

o Favorites Seraches. Provides a list of searches that you set and save as favorite. 
Also public searches stored by other users. 

Where <Search Page Name> is the name of the search page, such as Glossaries or ER 
Objects. 

Search Pages Index 
The following search pages for specific types of resources are available: 

o Glossaries 

o Terms 

o People 

o ER Objects 

o Data Sources 

o Apps 
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Glossaries 

Glossaries 
The Glossaries page is a search page that lets you search for glossaries, create new 
glossaries or load them from a CSV file. 

On the upper-right corner you can access the following commands: 

Item Description 

New Glossary Opens the New Glossary dialog box to create a new glossary. 

Export Glossaries Allows you to export glossaries and terms to a CSV file. 

Load Glossaries Opens the Load CSV File page to load glossaries and terms from a CSV file. 

Glossary Tool Tip Opens the Glossary Tool Tip start page. 

See Also 
o Searching for a Resource of a Specific Resource Type 

o Search Pages 
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Load CSV File 

Load CSV File 

 
Glossaries | click Load Glossaries 

The Load CSV File page provides a field, Choose a File, where you can specify the 
path to a CSV file of glossaries and terms that you want to load. 

After you choose the path to the target CSV file, click Load to actually load the file. 
ER/Studio Team Server reloads the page and displays information about the glossaries 
and terms added or modified as a result of loading the CSV file. 

See Also 
o Loading Glossaries and Terms from a CSV File 
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New Glossary 

New Glossary 
 

Glossaries | click New Glossary 

The New Glossary dialog box provides a set of fields that you can use to define a new 
glossary. 

After you finish filling the information about the new glossary, you can click Save to 
create your new glossary. You can click Cancel at any moment to abort. 

These are the fields that you can fill in this page: 
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New Glossary 

Item Description 

Name The name of the glossary. 

This is the only field required to create a new glossary. As soon as you fill the 
Name, you can click Save. You can edit any other details later. 

Parent 
Glossary 

An existing glossary that is a parent of the new glossary. 

As you write, ER/Studio Team Server offers names of existing glossaries for 
autocompletion. After you write the name of the parent glossary, click Add to 
actually select it. 

After you select a parent glossary, you can click on the right-hand side of the 
parent glossary name to remove it, so that you can select a different parent 
glossary. 

Status Text that describes the status of the glossary using nomenclature you decide 
upon. 

You can use for example the following nomenclature: "Approved", "Not Yet 
Approved", "Implemented", "Not Yet Implemented", and "Deprecated". 

Description Detailed information about the glossary, such as its purpose and audience. 

See Also 
o Creating a Glossary 
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Terms 

Terms 
The Terms page is a search page that lets you search for terms or create new terms. 

On the upper-right corner you can access the following command: 

Item Description 

New Term Opens the New Term dialog box to create a new term. 

See Also 
o Working with Terms 

o Search Pages 
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New Term 

New Term 
 

Terms | click New Term 

The New Term dialog box provides a set of fields that you can use to define a new term. 

After you finish filling the information about the new term, you can click Save to create 
your new term. You can click Cancel at any moment to abort. 

These are the fields that you can fill in this page: 
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New Term 

Item Description 

Name The name of the term. 

This is the only field required to create a new term. As soon as you fill the Name, 
you can click Save. You can edit any other details later. 

Status Text that describes the status of the term using nomenclature you decide upon. 

You can use for example the following nomenclature: "Approved", "Not Yet 
Approved", "Implemented", "Not Yet Implemented", and "Deprecated". 

Related 
Glossary 

Existing glossaries that are related to the new term. 

As you write, ER/Studio Team Server offers names of existing glossaries for 
autocompletion. After you write the name of a glossary, click Add to add it to the 
list of related glossaries. 

After you select a related glossary, you can click on the right-hand side of the 
glossary name to remove it. 

Description Detailed information about the term, such as its purpose and audience. 

See Also 
o Creating a Term 
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People 

People 
The People page is a search page that lets you search for ER/Studio Team Server users. 

See Also 
o Interacting with People 

o Search Pages 
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ER Objects 

ER Objects 
The ER Objects page is a search page that lets you search for ER objects. 

See Also 
o Searching for a Resource of a Specific Resource Type 

o Search Pages 

 
Embarcadero Technologies  114 

http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Search_Pages
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Search_Pages


Data Sources 

Data Sources 
The Data Sources page is a search page that lets you search for data sources or create 
new data sources or groups of them. 

To use the Data Source Advanced Search feature, click the link to the right of the search 
box. 

On the upper-right corner, you can access the following command: 

Item Description 

New Data Source Opens the New Data Source dialog box to create a new data source. 

New Group Opens the New Group dialog box to create a new group. 

Advanced Search Feature 

The data source advanced search feature allows you to add one or more search filters to 
narrow your search criteria. The search filters can search in a variety of details, 
connection types, or data source metrics. 

o Use the dropdown list to select the fields that you want to search. For example, 
Name or Location. 

o Use the next dropdown list to either match, not match, or find similar items. 

o Use the text box to enter your search criteria. The search is not case-sensitive. 

Using the add filter icon allows you to use multiple search filters at one time. 

You can save search filters with the Save Filter As button or load previously saved filters 
with the Load Filter button. 

See Also 
o Working with Data Sources 

o Working with Groups 

o Search Pages 
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New Data Source 

New Data Source 
 

Data Sources | click New Data Source 

The New Data Source dialog box provides a set of fields that you can use to define a 
new data source. 

After you finish filling the information about the new data source, you can click Save to 
create your new data source. You can click Cancel at any moment to abort. 

These are the fields that you can fill in this page: 
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New Data Source 

Item Description 

Name The name of the data source. 

Type Type of database management system (DBMS) that stores the database. 

<DBMS 
Fields> 

The fields after the Type field and before the Custom Properties field change 
depending on the selected DBMS Type. See Data Source Fields for a Specific 
Database Management System. 

Custom 
Properties 

Here you can define custom properties for the data source. 

For each property: 

1. Enter the Name of the property. 

2. Enter the Value for the property. 

3. Click Add to add the defined property-value pair to the list of 
properties of the data source. 

Description Detailed information about the data source, such as its purpose and audience. 

See Also 
o Creating a Data Source 
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Apps 

Apps 
The Apps page is a search page that lets you search for applications or create a new 
one. 

On the upper-right corner you can access the following command: 

Item Description 

New App Opens the New App dialog box to create a new App. 

See Also 
o Working with Apps 

o Developer Guide 
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New App 

New App 
 

Apps | click New App 

The New App dialog box provides a set of fields that you can use to define a new 
application. 

After you finish filling the information about the new app, you can click Save to create 
your new application. You can click Cancel at any moment to abort. 

 

These are the fields that you can fill in this page: 

Item Description 

Name The name of the app. 

This is the only field required to create a new term. As soon as you fill the Name, 
you can click Save. You can edit any other details later. 

Status Text that describes the status of the term using nomenclature you decide upon. 

You can use for example the following nomenclature: "Approved", "Not Yet 
Approved", "Implemented", "Not Yet Implemented", and "Deprecated". 

Description Detailed information about the term, such as its purpose and audience. 

See Also 
o Creating an App 
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User Menu 

User Menu 

 
The user menu lets you access to features that are specific to your user, and lets you 
customize your personal settings. 

The user menu contains two items: 

o My Settings. Hover this item to show a context menu with additional menu 
items. 

o Log Out. Logs you out of ER/Studio Team Server, ending your current user 
session. 
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User Menu 

My Settings Context Menu Items 
Item Description 

Help Displays the online help. 

Preferences Lets you define your email address, as well as your search and filtering 
preferences. 

Labels 
(only non-social 
users) 

Opens a list with your labels and labeled ER objects. See Working with ER 
Object Labels. 

Comments 
(only non-social 
users) 

Opens a list with your comments to ER objects. See Working with ER Object 
Comments. 

Watches 
(only non-social 
users) 

Opens a list with the ER objects that you are watching for updates. 

Admin 
(only super users) 

Gives you access to administrative functions. Manage licenses, permissions, 
data synchronization, schedules, and more. 

Activity 
(only super users) 

Displays graphics of login activity, connection activity, and ER object history. 
You can click the bars on the graphics to access detailed reports. 

SystemSettings 
(only super users) 

Gives you access to social administrator configuration. 

Notifications 
(only social users) 

Lets you configure your notification settings. 

See Also 
o User Guide 
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Activity 

Activity 

 
My Settings > Activity (super users) 

On this page you can see who is logged in to ER/Studio Team Server, view login denials, 
API connections and display a historical chart of connection activity. 

This page provides the following graphics: 

o Denials 

o Users 

o API Usage 

o Web Site Usage 

 

Denials 
This graphic shows the denials in a time period. To see further information, click in a 
graph node to pop up a dialog with the information about the denials, including User 
Name, Login Type and the Time of Denial. 

You can enter a start and an end date, and click Go to update the graphic so that it 
reflects the specified time period. 

When you hover the pointer over a node representing activity for a specific day, 
ER/Studio Team Server displays information about the graph node. 

Users 
This graphic shows the number of active Users in a cumulative chart by day in a time 
period. Also depicted is the Max Number of Licenses, showing the maximum allowed 
users. 

Clicking on a node pops up a separate dialog with detailed information of User Name, 
Login Type, License, and Time. 

If you hover your mouse over a node, it will pop up a tooltip giving specific information. 
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Activity 

API Usage 
This graphic shows the logins by license type and the total logins in a time period by 
API. 

Clicking on a bar pops up a separate dialog with detailed information of User Name, 
Login Type, License, and Time. 

If you hover your mouse over a node, it will pop up a tooltip giving specific information. 

You can enter a start and an end date, and click Go to update the graphic so that it 
reflects the specified time period. 

Web Site Usage 
This graphic shows the logins by license type and the total logins in a time period. 

You can select which license type, Connect or Portal to be displayed on the bar graph, 
by changing the drop-down list. 

If you hover your mouse over a node, it will pop up a tooltip giving specific information. 

You can enter a start and an end date, and click Go to update the graphic so that it 
reflects the specified time period. 

See Also 
o Tracking User Activity 

o Overview of Connection Licenses 

o Admin section 

o Report Pages 
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Admin Page 

Admin Page 

 
My Settings > Admin (super users) 

This section gives you access to pages where you can perform administrative tasks: 
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Admin Page 

Item Description 

Repository 
Management 

Lets you manage the Reporting Repository. 

Licenses Use this page to manage your ER/Studio Team Server licenses and check 
the activity of the logged-in users. 

Solution 
Permissions 

Lets you manage permission on Action Sequences for user and roles. 

ER/Studio 
Synchronization 

Use this page to synchronize the ER/Studio Repository database with the 
Reporting Repository database. See Overview of Data Synchronization. 

Comments 
(only non-social 
users) 

Act as a moderator to review, approve, and delete the comments other 
users have attached to ER objects. 

Schedules Use this page to check the status of the scheduler, suspend the scheduler, 
resume from suspend, or see a list of the schedule jobs. See Overview of 
Scheduling. 

Subscriptions A subscription binds an administrative function such as cleaning or 
synchronizing the repository to a schedule. 

Use this page to create and manage subscriptions, subscription schedules, 
and scheduled jobs. See Overview of Scheduling. 

Managed 
Attributes 
(only social users) 

Use this page to manage the attachment attributes of your ER objects. 

Interaction 
Settings 

Use this page to manage user interaction settings. You can allow/disallow 
users to moderate comments, provide the email address of the moderator, 
enable/disable sending emails for search results and reports. 

Object Alerts Use this page to access and edit any alert condition defined in ER/Studio 
Team Server. 

Term Entity Types Use this page to add, edit, or delete Term Entity Types. 

Manage Search 
Results 

Use this page to choose which fields are displayed in the search results for 
Data Sources 

Glossary Tool Tip Use this page to manage the glossaries that be returned for each URL 
Pattern. 

Permissions Use this page to manage permissions for users and groups. 

Team Server 4.0.1: In this version the link name is Access Control List 
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Admin Page 

Password Locker 
Audit 

Use this page to audit every connection to Password Lockers. 

See Also 
o Administrator Guide 
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Working with Resources 

Working with Resources 
ER/Studio Team Server gives you access to various types of resources: 

o Glossaries 

o Terms 

o People 

o ER Objects 

o Data Sources 

o Apps 

o Groups 

The following topics are shared by more than one type of resource: 

o Searching for a Resource of a Specific Resource Type 

o Favorite Searches for a Specific Resource Type 

o Editing a Resource 

o Discussing Resources 

o Following Resources 

o Editing the Stewards of a Resource 

o Adding an Attachment Attribute to a Resource Type 

o Loading Glossaries and Terms from a CSV File 

o Deleting a Resource 

See Also 
o Resource Pages 
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Adding an Attachment Attribute to a Resource Type 

Adding an Attachment Attribute to a 
Resource Type 
You can associate enterprise data dictionary attachments with the following ER/Studio 
Team Server resource types: glossaries, terms, people, data sources, and the following 
ER objects: tables, columns, logical entities, logical attributes, business entities and 
business attributes. 

When you associate an attachment to a resource type, the Description subpage of the 
pages of that type of resource include the associated attachment as a custom attribute 
which you can edit from ER/Studio Team Server. 

To associate an enterprise data dictionary attachment with a resource type: 

1. Select My Settings > Admin > Managed Attributes. 

2. Select the tab of the target type of resource. For example, Data Source. 

3. On the left-hand side column, click an attachment to select it. 

4. Click the icon to add the selected resource to the right-hand side column. 

The selected attachment is now associated with the current resource type. 

See Also 
o Resource Pages 
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Deleting a Resource 

Deleting a Resource 
You can delete a glossary, a term, or a data source as long as you are its original author 
(the user who creates the resource), a stewards of the resource, or a super user. 

To delete a resource of any of those types: 

1. Open the page of the target resource. You can search for it. 

2. On the resource page, click [Delete] on the header. 

3. On the confirmation dialog box that opens, click OK. 

The target resource is not available anymore in ER/Studio Team Server. 

Note: Deleting a resource does not delete the resources that are related to it. For 
example, if you delete a glossary, any term associated with it remains in ER/Studio 
Team Server. 

See Also 
o Creating a Glossary 

o Creating a Term 

o Creating a Data Source 
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Discussing Resources 

Discussing Resources 
ER/Studio Team Server lets you keep discussions with other ER/Studio Team Server 
users about any resource (glossaries, terms, ER objects, and data sources). 

You can access the discussions about a specific resource from the Discussions subpage 
of the target resource page. 

Topics 
o Starting a Discussion about a Resource 

See Also 
o Following Resources 

o Adding a Comment to an ER Object 
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Starting a Discussion about a Resource 

Starting a Discussion about a Resource 
To start a discussion about a resource: 

1. Open the page of that resource. You can try searching for it. 

2. Open the Discussions subpage. 

3. Click New Discussion on the top-right corner. 

4. On the New Discussion dialog that opens:  

1. Write the discussion title in the upper, one-line field. 

2. Write your initial discussion message inside the multi-line text field. 

3. Click Create to start the discussion. 

Your new discussion topic is added to the list of topics in the Discussions page so that 
other people can see it and join the discussion. 

See Also 
o Discussions page 
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Editing a Resource 

Editing a Resource 
To edit a glossary, a term, or a data source: 

1. Open the page of the target resource. You can search for it. 

2. Open the Description subpage. 

3. Click Edit to enter the edit mode. In edit mode, the Description page provides 
fields to define the values of each property of the target resource. 

4. Modify the resource properties.  

Tip: For information about the fields that you can edit, check the documentation of the 
description page of the type of resource that you are editing: glossary, term, or data 
source. 

5. To save your changes, click Save at the end of the page. 

Note: To automatically update any matched items to the edited changes, the Auto 
Match tick box on the Found In tab must be enabled. 

See Also 
o Editing the Stewards of a Resource 

o Working with Glossaries 

o Working with Terms 

o Working with Data Sources 
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Editing the Stewards of a Resource 

Editing the Stewards of a Resource 
To add or remove stewards from a resource: 

1. Open the page of the target resource. You can search for it. 

2. Open the Description subpage. 

3. Click Edit on the right-hand column, on the right-hand side of Stewards, to enter 
the edit mode. 

4. In edit mode, you can:  

 Enter the name of a user into the text field and click Add to add that user 
to the list of stewards. 

 Click on the right-hand side of an existing steward to remove that user 
from the list of stewards. 

5. To save your changes, click Done on the right-hand side of the Stewards header. 

See Also 
o Overview of Stewards 

o Editing a Resource 
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Following Resources 

Following Resources 
ER/Studio Team Server keeps track of people activity surrounding resources 
(glossaries, terms, ER objects, and data sources). It records when someone edits a 
resource, posts a comment to a resource, and so on. 

You can follow a resource so that you can keep track of all the activity that surrounds 
that resource. You can see the activity of every resource that you are following in your 
Home page. 

Topics 
o Following a Resource 

o Posting a Comment to a Resource 

o Unfollowing a Resource 

See Also 
o Discussing Resources 

o Watching ER Objects for New Comments 

o Stream page 

o Followers page 
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Following a Resource 

Following a Resource 
To start following a resource: 

1. Open the page of that resource. You can try searching for it. 

2. Click + Follow on the upper-right corner of the resource page header. 

You are now following the resource, and its activity is displayed in your Home page. 

See Also 
o Unfollowing a Resource 
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Posting a Comment to a Resource 

Posting a Comment to a Resource 
You can post a comment to a ER/Studio Team Server resource (glossaries, terms, ER 
objects, and data sources) so that people following that resource is notified, and anyone 
can read your comment in the Stream subpage of the resource page. 

To post a comment to a resource: 

1. Open the page of that resource. You can try searching for it. 

2. Open the Stream subpage. 

3. Write your comment into the field with the text "Write a comment...", and 
click     ↵ to send your comment. 

ER/Studio Team Server adds your comment to the Stream page, and notifies any user 
following the resource. 

See Also 
o Following a Resource 

o Stream page 

 
Embarcadero Technologies  136 



Unfollowing a Resource 

Unfollowing a Resource 
To stop following a resource: 

1. Open the page of that resource. You can try searching for it. 

2. Click Following on the upper-right corner of the resource page header. 

You are not following the resource anymore , and its activity is no longer displayed in 
your Home page. 

See Also 
o Following a Resource 
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Manage User Permissions on a Resource 

Manage User Permissions on a 
Resource 
To manage User Permissions: 

1. Select Permissions page and then select Users tab. 

2. Click the Edit button on the upper-right corner. 

The Manage User Permissions page shows a permissions table where you can set 
specific permissions for Glossaries, ER Objects, Datasources, Login Credendials, Reports 
and Applications. 

 
It shows the following options for each element type: 

 

Item Description 

List/View Check this option to allow only read permissions. 

Create Check this option to allow creating the resources. 

Update/Delete Check this option to allow editing and deleting the resources. 

Stewards Check this option to allow user to manage the Stewards of a resource. 

 

The Groups Membership table allows you to include the user on permissions groups. 

Click the Save button to save your settings. 
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Manage Group Permissions on a Resource 

Manage Group Permissions on a 
Resource 
To manage Groups Permissions: 

1. Select Permissions page and then select Groups tab. 

2. Click the Edit button on the upper-right corner. 

The Manage Groups Permissions page shows a permissions table where you can set 
specific permissions for Glossaries, ER Objects, Datasources, Login Credendials, Reports 
and Applications. 

 
It shows the following options for each element type: 

 

Item Description 

List/View Check this option to allow only read permissions. 

Create Check this option to allow creating the resources. 

Update/Delete Check this option to allow editing and deleting the resources. 

Stewards Check this option to allow user to manage the Stewards of a resource. 

 
The Members table allows you to include the user on permissions groups. 
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Manage Group Permissions on a Resource 

 
You can also modify the name and the description of the group on this page. 

Click Save button to save your settings. 

 

See Also 
o Admin 

o Manage User Permissions on a Resource 

o Deleting a Permissions Group 
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Interacting with People 

Interacting with People 
You can interact with social users (people) as you interact with any other ER/Studio 
Team Server resource. They have their own search page, resource page and subpages, 
and so on. 

To see the details of a user, find it and open its person page. 

Topics 
o Searching for a User 

o Following People 

o Adding an Attachment Attribute to People 

See Also 
o People search page 

o Person Pages 
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Loading Glossaries and Terms from a CSV File 

Loading Glossaries and Terms from a 
CSV File 
You can load into ER/Studio Team Server, glossaries and terms from CSV file if you 
have a CSV file that follows the required format. 

To load glossaries and terms from a CSV file: 

1. Select Glossaries on the navigation menu. 

2. Click Load Glossaries on the upper-right corner of the Glossaries page. 

3. On the Load CSV File page that opens:  

1. Click Browse and choose the target CSV file. 

2. Click Load. 

ER/Studio Team Server loads the glossaries and terms on the CSV file. 

Note: If you have any formatting errors in your csv file, you may receive an error 
message. The log file that you can check for any import errors is located at: ...installation 
path\Embarcadero Team Server 4.0\logs\ersportal.log 

See Also 
o Creating a Glossary 

o Creating a Term 
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CSV Format to Load Glossaries and Terms 

CSV Format to Load Glossaries and 
Terms 
ER/Studio Team Server can load CSV (comma-separated values) files containing 
information about glossaries and terms as long as they follow the expected format. 

Later in this topic are some examples of the format required to import either Glossaries 
or Terms. 

Each set of rows contains four or more rows with the following content: 

o The first row contains a fixed value, the start tag, which depends on the type of 
resource:  

 If you want to define a glossary: +++ Glossaries Begin +++. 

 If you want to define a term: +++ Terms Begin +++. 

o The second row contains a comma-separated list of the names of properties of 
the target type of resource that we want to define later. Only the resource name 
is mandatory. 

o Between the second row and the last row you can insert as many rows as you 
want. Each one of the rows represents a single glossary or term, and contains a 
comma-separated list of property values for that resource. The order that you 
have to use to specify the resource property values is that of the property names 
in the second row. 

o The last row contains a fixed value, the end tag, which depends on the type of 
resource:  

 If you defined a glossary: +++ Glossaries End +++. 

 If you defined a term: +++ Terms End +++. 

See also the examples of CSV files below. 

Properties that You Can Use in Your CSV File 
The property names that you can use on the second row of a set depends on whether 
your set defines a glossary or a term. 
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CSV Format to Load Glossaries and Terms 

Glossary Properties 

Item Description 

Key This value is filled when exporting existing glossaries and terms. Updating 
with the key now allows you to modify the name without creating new ones. 
The Key field is left empty when creating new glossaries. 

Name 
(mandatory) 

Name of the glossary. 

Status Chosen Status (this is a status of the glossary that is predefined by you). 

Stewards List of usernames of ER/Studio Team Server users that must become 
stewards of the new glossary. 

Separate values with a semicolon. For example: username1;username2. 

Definition Definition of the new glossary. 

Abbreviations An Abbreviation of the glossary. 

Aliases An alias for the glossary. 

AdditionalNotes Anything you would like to define in the Additional Notes section of your 
glossary. 

ParentGlossary Name of the parent glossary, in case you wish to structure your Glossary as 
a child of another glossary. 

[CustomAttributes] Indicate the name of a custom attribute in the column header and value in a 
row. A custom attribute should be assigned to glossaries in advance or it 
will be ignored. 
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CSV Format to Load Glossaries and Terms 

Term Properties 

Item Description 

Key This value is filled when exporting existing glossaries and terms. Updating 
with the key now allows you to modify the name and term type, without 
creating new ones. The Key field is left empty when creating new terms. 

Name 
(mandatory) 

Name of the term. 

Status Chosen Status (this is a status of the term that is predefined by you). 

Stewards List of usernames of ER/Studio Team Server users that must become 
stewards of the new term. 

Separate values with a semicolon. For example: username1;username2. 

Definition Definition of the new term. 

Abbreviations An Abbreviation of the term. 

Aliases An alias for the term. 

AdditionalNotes Anything you would like to define in the Additional Notes section of your 
term. 

RelatedGlossaries Name of any related glossaries. 

Separate values with a semicolon. For example: Glossary1;Glossary2. 

RelatedTerms Name of any related terms. 

Separate values with a semicolon. For example: Term1;Term2. 

TermEntityType Name of the Term Entity Type. This can be predefined by you when 
creating terms, or from the Term Entity Types subpage of the admin 
pages. 

[CustomAttributes] Indicate the name of a custom attribute in the column header and value in a 
row. A custom attribute should be assigned to glossaries in advance or it 
will be ignored. 

Custom Attributes 

The custom attributes format depends on the type. 
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CSV Format to Load Glossaries and Terms 

Type Format Example 

Date MM/DD/YYYY. 01/23/2013 

Boolean True or False True 

Time HH:MM:A 01:25 PM 

Numeric Integer Number 364 

External File Path String \\servername\file.txt 

Text String Some Text 

Text List String and matching valid values Value1 

Examples of Valid CSV Files 
These are some example CSV files that you can load into ER/Studio Team Server. 

Single Glossary 

The following CSV code defines a single glossary named "Accounting". 
 
+++ Glossaries Begin +++ 
Key,Name,Status,Definition,Abbreviations,Aliases,AdditionalNotes,Stewards,,,,,,
,, 
,Accounting,Approve,"Glossary of commonly used accounting 
terms.",,,,admin,,,,,,,, 
+++ Glossaries End +++ 
 

Terms 

The following CSV code defines terms named "AMT" and "Abatement". 
 
+++ Terms Begin +++ 
Key,Name,Status,Definition,Abbreviations,Aliases,AdditionalNotes,Stewards,Relat
edGlossaries,RelatedTerms,TermEntityType 
,AMT,Approved,"Tax imposed to back up the regular income tax imposed on 
CORPORATION and individuals to assure that taxpayers with economically measured 
income exceeding certain thresholds pay at least some income 
tax.",,,,admin,Accounting,, 
,Abatement,Approved,"Complete removal of an amount due, (usually referring to a 
tax ABATEMENT a penalty abatement or an INTEREST abatement within a governing 
agency).",,,,admin,Accounting,AMT, 
+++ Terms End +++ 
 

See Also 
o Creating a Glossary 
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CSV Format to Load Glossaries and Terms 

o Creating a Term 
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Searching for a Resource of a Specific Resource Type 

Searching for a Resource of a Specific 
Resource Type 
To search for resources of a specific resource type (glossaries, terms, people, ER objects, 
or data sources): 

1. Select the search page of the target resource type: Glossaries, Terms, People, 
ER Objects, or Data Sources. 

2. Enter your search terms in the search field. 

As soon as you stop typing, ER/Studio Team Server filters the list of resources and 
displays only resources that meet your search criteria. Click their name to open their 
resource page. 

Advanced Search 
Using the advanced search you have more control of the search than with any other 
search box in ER/Studio Team Server. For advanced search: 

1. Click Advanced button search page of the target resource. 

2. In the Property drop-down list select the property you want to filter for. 

3. Select the condition: Is, Like, Not Like... 

4. In the Value field, enter a valid value for the selected property. This will limit the 
search results. 

5. Click Search. The Advanced Search page reloads to show the search results. 

If you need to add additional filters, click the button on the right-hand side of the first 
set of filter fields. 

Favorite Searches 
After completing an advanced search, you can name and save the search for later use. 

To save an advanced search as favorite: 

1. Perform an advanced search. 

2. Click Save Search As. 

3. On the New Search dialog box that opens:  

 Enter a descriptive Name for your search. 

 Optionally, write a Description that provides additional details that 
would not fit the search name. 
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Searching for a Resource of a Specific Resource Type 

 Optionally, check the Shared checkbox to make your new favorite search 
public, so that any other user can access your search from the Favorite 
Searches page. If you leave this option unchecked, only you can access 
your new favorite search from the Favorite Searches page. 

After you save your new Advanced Search as favorite, you can find it in the Favorite 
Searches page. 

See Also 
o Search Pages 

o Favorite Searches for a Specific Resource Type 
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Working with Glossaries 

Working with Glossaries 
Glossaries are collections of terms, such as "Human Resources", "Travel Department", 
or "Customer Service". Glossaries can contain many terms, and each term can be 
associated with many glossaries. 

When you create a glossary or load them from a CSV file, you become its owner. Only 
you or a super user can add terms to it or delete it. 

To see the details of an existing glossary, find it and open its glossary page. 

Topics 
o Creating a Glossary 

o Loading Glossaries from a CSV File 

o Searching for a Glossary 

o Editing a Glossary 

o Adding a Term to a Glossary 

o Adding a Child to a Glossary 

o Discussing Glossaries 

o Following Glossaries 

o Editing the Stewards of a Glossary 

o Adding an Attachment Attribute to Glossaries 

o Deleting a Glossary 

o Glossary Tool Tips 

See Also 
o Glossaries search page 

o Glossary Pages 

o Working with Terms 
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Adding a Child to a Glossary 

Adding a Child to a Glossary 
To make an existing glossary a child of another glossary: 

1. Open the page of the parent-to-be glossary. You can search for it. 

2. Open the Children subpage. 

3. Open the Manage tab. 

4. In the list of existing glossaries, click Add Child on the right-hand side of a 
glossary to add as a child of the current glossary.  

Notes: 

 You can use the search field at the top of the page to filter the list of existing 
glossaries. 

 You can click Remove Child on right-hand side of a glossary, on any of the tabs, 
to remove the glossary from the list of children of the current glossary. 

See Also 
o Creating a Glossary 

o Children subpage 
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Adding a Term to a Glossary 

Adding a Term to a Glossary 
To add existing terms to a glossary: 

1. Open the page of the target glossary. You can search for it. 

2. Open the Terms subpage. 

3. Open the Relate tab. 

4. In the list of existing terms, click Relate on the right-hand side of a term to add it 
to the current glossary.  

Notes: 

 You can use the search field at the top of the page to filter the list of existing 
terms. 

 You can click Unrelate on right-hand side of a term, on any of the tabs, to 
remove the term from the current glossary. 

See Also 
o Creating a Term 

o Associating a Term with a Glossary 

o Related Terms subpage 
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Creating a Glossary 

Creating a Glossary 
To create a glossary: 

1. Select Glossaries. 

2. Click the New Glossary button on the upper-right corner. 

3. In the New Glossary dialog box that opens:  

1. Enter a Name to identify your new glossary. 

2. Optionally, if you want your new glossary to be a child of an existing 
glossary:  

1. Write in Parent Glossaries the name of an existing glossary.  

Tip: As you write the name of the parent glossary, a context menu appears listing 
existing glossaries. You can click an item in the context menu instead of manually writing 
the whole name of the parent glossary. You can select multiple parent glossaries. 

2. Click Add to set the parent.  

Note: Click the icon to the right-hand side of the parent name to unset the parent 
glossary. 

3. Define the Status of the glossary using nomenclature you decide upon. 
You can use for example the following nomenclature: "Approved", "Not 
Yet Approved", "Implemented", "Not Yet Implemented", and 
"Deprecated". 

4. Write a Definition that provides detailed information about the glossary, 
such as its purpose and audience. 

5. Click Save to save your new glossary. 

See Also 
o Adding a Child to a Glossary 

o Associating a Term with a Glossary 

o Deleting a Resource 

o New Glossary dialog box 
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Glossary Tool Tip 

Glossary Tool Tip 
Glossary Tool Tips are links to your ER/Studio Team ServerGlossaries of matched 
words and phrases in your browser. When you browse any web page that is in your list of 
configured sites, matched Terms are automatically highlighted. 

The page below is an example of a pop-up definition of the underlined Term. 

 

The underlined matches are Terms found in your ER/Studio Team Server installation. 
When you hover your mouse over the underlined word, the pop-up box will show the 
first definition found in your list of Terms. A link is provided to open your browser to your 
ER/Studio Team Server pages of the related Term, where you can browse your company 
Glossaries for other related Terms and ER Objects. 

After your Glossary Tool Tips are enabled, browsing on any web page that has been 
configured to be included will cross reference any matching Terms in your ER/Studio 
Team Server installation. 

Note: Glossary Tool Tip is currently only available for Firefox web browser and 
requires Greasemonkey Add-on. 

Note: You do not need to be signed in to ER/Studio Team Server to use Glossary 
Tool Tip, however if your ER/Studio Team Server installation uses a secure HTTPS 
connection then the ER/Studio Team Server's digital certificate must have previously 
been accepted/imported/installed. 

See Also 
o Installing Glossary Tool Tips 

o Glossaries 

o Manage Glossary Tool Tips 
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Installing Glossary Tool Tips 

Installing Glossary Tool Tips 
 
To enable Glossary Tool Tips on your browser: 

1. Install the Firefox browser Greasemonkey Add-on. 

2. Open Glossaries from the Navigation Menu and click the button. 

Note: The link is also available by clicking Click here for more information at the 
bottom of every page, including the initial page, prior to log on. 

1. On the page that opens, click the button to install the 
Greasemonkey script. 

 
By default, the script has all web pages enabled. Your Administrator can include and 
exclude various websites by editing the settings using the administration interface, see 
Manage Glossary Tool Tips. 

When you browse to an included page that has Terms matched to a Term in your 
Glossaries, it will be underlined. Hover over the underlined Term with your mouse to 
show the definition or click the popup to open in Connect. 

 

See Also 
o Manage Glossary Tool Tips 

o Glossary Tool Tip 

o Glossaries 

o Terms 
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Working with Terms 

Working with Terms 
Terms represent general concepts related to the business, such as "Social Security", 
"Tax ID", "Zip Code", or "Call Resolution Time". 

When you create a term, you become its owner. You can then associate your term with 
ER objects, with glossaries, and with other terms. To see the details of an existing term, 
find it and open its term page. 

Topics 
o Creating a Term 

o Loading Terms from a CSV File 

o Searching for a Term 

o Editing a Term 

o Associating a Term with a Glossary 

o Associating a Term with Another Term 

o Associating a Term with an ER Object 

o Linked Terms 

o Matching a Term with ER Objects 

o Discussing Terms 

o Following Terms 

o Editing the Stewards of a Term 

o Adding an Attachment Attribute to Terms 

o Deleting a Term 

See Also 
o Terms Search Page 

o Term Pages 

o Term API 

o Working with Glossaries 
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Associating a Term with a Glossary 

Associating a Term with a Glossary 
To associate a term with an existing glossary: 

1. Open the page of the target term. You can search for it. 

2. Open the Related Glossaries subpage. 

3. Open the Relate tab. 

4. In the list of existing glossaries, click Relate on the right-hand side of a glossary 
to associate it with the current term.  

Notes: 

 You can use the search field at the top of the page to filter the list of existing 
glossaries. 

 You can click Unrelate on right-hand side of a glossary, on any of the tabs, to 
disassociate the glossary with the current term. 

See Also 
o Creating a Glossary 

o Adding a Term to a Glossary 

o Related Glossaries subpage 
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Associating a Term with an ER Object 

Associating a Term with an ER Object 
To associate an existing term with ER objects: 

1. Open the page of the target term. You can search for it. 

2. Open the Related ER Objects subpage. 

3. Open the Relate tab. The tab contains a search page, similar to the ER Objects 
page. 

4. In the list of ER objects, click Relate on the right-hand side of an ER object to 
associate it with the current term.  

Notes: 

 You can use the search field at the top of the page to filter the list of existing ER 
objects. 

 You can click Unrelate on the right-hand side of an ER object to break its relation 
with the current term. 

See Also 
o Associating an ER Object with a Term 

o Related ER Objects subpage 
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Associating a Term with Another Term 

Associating a Term with Another Term 
To associate an existing term with another existing term: 

1. Open the page of one of the terms. You can search for it. 

2. Open the Related Terms subpage. 

3. Open the Relate tab. 

4. In the list of terms, click Relate on the right-hand side of a term to associate it 
with the current term.  

Notes: 

 You can use the search field at the top of the page to filter the list of existing 
terms. 

 You can click Unrelate on the right-hand side of a term to break its relation with 
the current term. 

 As well as with relating terms, you may also group terms by Term Entity Type. 
See the Creating a Term page on how to do this. 

See Also 
o Creating a Term 

o Related Terms subpage 
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Creating a Term 

Creating a Term 
To create a term: 

1. Select Terms. 

2. Click the New Term button on the upper-right corner. 

3. On the New Term dialog box that opens:  

1. Enter the Name of your new Term. 

2. Define the Status of the Term using a nomenclature you decide upon. 
You can use for example the following nomenclature: "Approved", "Not 
Yet Approved", "Implemented", "Not Yet Implemented", or 
"Deprecated". 

3. You are also able to choose a Term Entity Type. You can also choose 
your own nomenclature. For example, Entity Term Type could provide a 
way to distinguish between different types of Terms. This makes it easier 
for you to see the relationship and understand the distinction. It also 
allows for Terms with the same name but different type. Examples of 
types might include the Subject Area, Documents, Reports or Domains. 

4. Optionally, if you want to add your new Term to existing glossaries, for 
each one of those glossaries:  

1. Write in the Related Glossaries text field the name of the 
glossary.  

Tip: As you write the name of the glossary, a context menu appears listing existing 
glossaries. You can click an item in the context menu instead of manually writing the 
whole name of the glossary. 

2. Click Add to include the glossaries in the list of related glossaries.  

Note: Click the icon to the right-hand side of a glossary in the list under Related 
Glossaries to remove the glossary from the list of related glossaries. 

5. Write a Description that provides detailed information about the Term, 
such as its purpose and audience. 

6. Click Save to save your new Term. 

See Also 
o Adding a Term to a Glossary 

o Associating a Term with Another Term 

o Deleting a Resource 

o Glossaries search page 
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Linked Terms 

Linked Terms 
Linked Terms allow you to implement Terms in your Glossaries much faster and make 
use of taxonomies already in use. 

A Linked Term is a term associated to an ER Object, taking the name and description 
from it. Linked Terms are automatically created when a Domain, Model or Submodel ER 
Object is synchronized. Their properties are populated from the ER Object. 

It is possible to create Linked Terms by clicking the option in the header of the ER 
Object. 

Note: Linked Terms can be exported but cannot be imported since they only exist 
when linked to an object. 

See Also 
o Creating a Term 

o Related Terms subpage 
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Matching a Term with ER Objects 

Matching a Term with ER Objects 
ER/Studio Team Server lets you associate any term with ER objects that contain the 
target term. 

To match an existing term with ER objects: 

1. Open the page of the target term. You can search for it. 

2. Open the Related ER Objects subpage. 

3. Open the Found In tab. The tab contains a search page, similar to the ER 
Objects page. 

4. Click Refresh. 

ER/Studio Team Server finds any ER object that contains the current term in its name or 
description, and adds it to the Found In tab. You can also see matched ER objects in the 
View tab, listed after related ER objects. 

In the Found In tab, you can click the Unmatch button. This will remove the matching of 
the ER object and it will no longer be listed under the View tab. The Re-Match button 
will match ER objects that you manually unmatched. 

Clearing the Auto Match tick box will disable the Auto Match function and any items 
that you Unmatch will be saved. 

See Also 
o Matching an ER Object with Terms 

o Related ER Objects subpage 

 
Embarcadero Technologies  162 

http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/ER_Object_Pages
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Related_ER_Objects
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/ER_Objects
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/ER_Objects
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Related_ER_Objects


Working with ER Objects 

Working with ER Objects 
ER objects are objects from ER/Studio Repository that you can access from ER/Studio 
Team Server. 

To see the details of an ER object, find it and open its ER object page. To find an ER 
object, you can: 

o Browse your ER objects using the Model Explorer page. 

o Use the simple search. 

o Use the advanced search. 

Topics 
o Browsing ER Objects 

o Searching for an ER Object 

o Using the Advanced Search of ER Objects 

o Associating an ER Object with a Term 

o Matching an ER Object with Terms 

o Discussing ER Objects 

o Following ER Objects 

o Adding an Attachment Attribute to ER Objects 

o Configuring Sensitive Data Alerts 

o Working with ER Object Comments 

o Working with ER Object Labels 

See Also 
o Synchronizing with ER/Studio Repository 

o Working with ER Object Comments 

o Working with ER Object Labels 

o ER Objects Search Page 

o ER Object Pages 

o Linked Terms 
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Associating an ER Object with a Term 

Associating an ER Object with a Term 
To associate an ER object with an existing term: 

1. Open the page of the target ER object. You can search for it. 

2. Open the Related Terms subpage. 

3. Open the Relate tab. The tab contains a search page, similar to the Terms page. 

4. In the list of terms, click Relate on the right-hand side of a term to associate it 
with the current ER object.  

Notes: 

 You can use the search field at the top of the page to filter the list of existing 
terms. 

 You can click Unrelate on the right-hand side of a term to break its relation with 
the current ER object. 

See Also 
o Linked Terms 

o Associating a Term with an ER Object 

o Related Terms subpage 
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Browsing ER Objects 

Browsing ER Objects 

 
You can browse the hierarchy of ER objects from the Model Explorer page. 

In this hierarchy, you can expand every ER object too see its content, and you can click 
any ER object to access its description page, which contain links that you can use to 
continue browsing your ER objects. 

As you hover over certain ER objects, such as diagrams, ER/Studio Team Server displays 
pop-up windows with detailed information about the ER object. Hovering over the name 
of an ER object with an eye icon, such as a model or a submodel, displays a miniature 
picture of the ER object. 

See Also 
o Searching for a Resource of a Specific Resource Type 

o Working with ER Object Comments 

o Working with ER Object Labels 

o ER Object Pages 

o Overview of Data Synchronization 

 
Embarcadero Technologies  165 

http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Model_Explorer
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/ER_Object_Pages%23ER_Object_Description_Page
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/ER_Object_Pages
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Overview_of_Data_Synchronization


Configuring Sensitive Data Alerts 

Configuring Sensitive Data Alerts 

 
Header of an ER object that matches two alert conditions. 

You can configure security properties and attachments so that ER/Studio Team Server 
displays custom alerts on the header of the pages of ER objects bound to those security 
properties and attachments, or that have a specific value for those. 

This feature lets you warn about sensitive data. For example, you can show a message 
on any ER object bound to a certain security property with a value of "High", and 
describe in the alert the risks of not keeping the ER object information confidential. 

To configure these sensitive data alerts, you must define alert conditions using the 
Alerts page of the target security property or attachment. 

Topics 
o Adding a Sensitive Data Alert Condition 

o Editing a Sensitive Data Alert Condition 

o Deleting a Sensitive Data Alert Condition 

See Also 
o Alerts subpage 

o Object Alerts page 
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Adding a Sensitive Data Alert Condition 

Adding a Sensitive Data Alert 
Condition 
To add a sensitive data alert condition to a security property or attachment: 

1. Open the page of the target ER object. You can search for it. 

2. Open the Alerts subpage. 

3. Click Add New Condition to add a new alert condition resource to the page. 

4. On the new alert condition resource:  

1. On the Show Alert for Matching field, select one of the following values:  

 Bound Object if you want the alert condition to affect any ER 
object bound to the current security property or attachment. 

 Value if you want the alert condition to affect any ER object 
bound to the current security property or attachment with a 
specific value. Enter the target value into the input field on the 
right-hand side. 

2. Select an Alert Level, either Notice or Info. The alert level determines 
the icon that ER/Studio Team Server shows along with the Notification 
Text. 

3. Enter into Notification Text the text of the notification. 

4. From the Notification Text field, press ⇆     to take the focus out of 
the field. ER/Studio Team Server saves field values as you take the focus 
out of them. 

Your alert condition is now in effect. You can edit it later or delete it. 

See Also 
o Editing a Sensitive Data Alert Condition 

o Deleting a Sensitive Data Alert Condition 

o Alerts subpage 
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Deleting a Sensitive Data Alert Condition 

Deleting a Sensitive Data Alert 
Condition 
There are two methods of deleting an existing sensitive data alert condition: 

Option 1: 

1. Open the page of the security property or attachment that contains the alert 
condition. You can search for it. 

2. Open the Alerts subpage. 

3. Click Delete Condition on the target alert condition resource. 

Option 2: 

1. Go to My Settings > Admin > Object Alerts (super users). 

2. On the right of the condition you want to delete, click the blue Delete button. 

3. Click OK on the deletion warning popup. 

While super users can delete any alert condition, authenticated users can only delete the 
alert conditions that they create. 

See Also 
o Adding a Sensitive Data Alert Condition 

o Editing a Sensitive Data Alert Condition 

o Alerts subpage 
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Editing a Sensitive Data Alert Condition 

Editing a Sensitive Data Alert 
Condition 
To edit an existing sensitive data alert condition: 

1. Open the page of the security property or attachment that contains the alert 
condition. You can search for it. 

2. Open the Alerts subpage. 

3. Locate and modify the target alert condition resource. 

ER/Studio Team Server saves text input field values as you take the focus out of them. 
After you change a text value, press ⇆     or change another option so that 
ER/Studio Team Server saves your changes. 

Alternatively, if you are a super user, you can edit any existing alert condition from the 
Object Alerts page. 

See Also 
o Adding a Sensitive Data Alert Condition 

o Deleting a Sensitive Data Alert Condition 

o Alerts subpage 

o Object Alerts page 
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Matching an ER Object with Terms 

Matching an ER Object with Terms 
ER/Studio Team Server lets you associate any ER object with terms that contain the 
target ER object. 

To match an existing ER object with terms: 

1. Open the page of the target ER object. You can search for it. 

2. Open the Related Terms subpage. 

3. Open the Match tab. The tab contains a search page, similar to the Terms page. 

4. Click Refresh. 

ER/Studio Team Server finds any term that is present in the name or the description of 
the current ER object, and adds it to the Match tab. You can also see matched terms in 
the View tab, listed after related terms. 

In the Match tab, on the right-hand side of the term entries, you can click Unmatch to 
unmatch matched terms, or click Re-Match to match terms that you manually 
unmatched. 

See Also 
o Matching a Term with ER Objects 

o Related Terms subpage 
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Using the Advanced Search of ER Objects 

Using the Advanced Search of ER 
Objects 
Using the advanced search you have more control of the search than with any other 
search box in ER/Studio Team Server. 

Using the advanced search, you can: 

o Specify that the property value starts with, contains, ends with, or is an exact 
match to the text. 

o Set filters to include or exclude results based on modification dates and specific 
ER object types. 

o Set how you want the search results sorted. 

o Specify the number of results to display per page. 

Topics 
o Searching for an ER Object Using the Advanced Search 

o Saving Favorite Searches 

o Sending Searches By Email 

o Writing an Advanced Search String 

See Also 
o Advanced Search page 
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Searching for an ER Object Using the Advanced Search 

Searching for an ER Object Using the 
Advanced Search 
To perform an advanced search: 

1. Open the Advanced Search page. 

2. In the Search Text field, enter a valid search string. 

3. Check "Include matches for similar-sounding words" to search for text that 
sounds like the search text. 

4. In the Filters field, select any of the available options:  

 All. Search for any ER object. 

 Data. Search only for ER/Studio Data Architect objects. 

 Business. Search only for ER/Studio Business Architect objects. 

5. In the Modification area, you can define a specific period of time and user. The 
search results only contain ER objects modified by the specified user during the 
specified period of time.  

1. In the Modified field, select a period of time. Select "anytime" not to 
restrict results by their last modification date. 

2. In the By field, enter the name of a user. Leave the field empty not to 
restrict the results to those modified by a specific user. 

2. In the Object Type area, you can select the ER object types that you want to 
include in the search. To select multiple items in the list, hold the Ctrl key and 
click the target items. To not filter by ER object type, check the All option. 

3. In the Property area, you can define pairs of properties and values that must 
match in the search results. To add a property-value pair to filter the search 
results:  

1. In the Name field:  

1. Click the ellipsis button. ER/Studio Team Server displays a list of 
properties. 

2. Select the target object type in the Highlight properties for 
combo box. 

3. Click the target property from the list of properties. 

2. In the Value field, enter a valid value for the selected property. This will 
limit the search results to ER objects where the selected property has this 
value. 
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Searching for an ER Object Using the Advanced Search 

3. Optionally, click on the left-hand side of the Name and Value fields to 
indicate that this is an mandatory inclusion search criteria.  

Notes: 

 If you do not click the search string is considered optional, and not required for 
a match. 

 Click to exclude the specified property-value pair from the search results. 

If you need additional property-value fields, click the button on the right-hand side of 
the first set of Name and Value fields. 

4. In the Sorting combo box, you can select a field to sort the search results. 

5. In the Pagination combo box, you can select the number of results to show per 
page. 

6. Click Search. The Advanced Search page reloads to show the search results. 

The results of the advanced search are displayed by default in HTML format. To view the 
results in table format, click View as table at the top left-hand side of the results results 
page. 

At the bottom of the search results page you can specify a different search criteria, and 
search again to further refine your search. 

See Also 
o Writing an Advanced Search String 

o Saving Favorite Searches 

o Advanced Search 
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Saving Favorite Searches 

Saving Favorite Searches 
After completing and running an advanced search, you can name and save the search 
for later use. 

To save an advanced search as favorite: 

1. Perform an advanced search. 

2. After ER/Studio Team Server loads the search results, click the icon in the 
results header. 

3. On the Add to favorite dialog box that opens:  

1. Enter a descriptive Name for your search. 

2. Optionally, write a Description that provides additional details that 
would not fit the search name. 

3. Optionally, check the Shared checkbox to make your new favorite search 
public, so that any other user can access your search from the Favorite 
Searches page. If you leave this option unchecked, only you can access 
your new favorite search from the Favorite Searches page. 

After you save your new advanced search as favorite, you can find it in the Favorite 
Searches page. If you are a non-social user, you can find your favorite searches in the 
Home page as well. 

In addition to the search text, saved searches include the ordering and filter settings. 

See Also 
o Using the Advanced Search of ER Objects 

o Favorite Searches page 

o Search Results page 

o Home (non-social) page 
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Sending Searches By Email 

Sending Searches By Email 
If emailing search results is enabled, follow these steps to send an advanced search for 
ER objects by email: 

1. Perform the advanced search. 

2. On the results page, click . 

3. On the Email Search Results dialog box that opens:  

1. Specify in To an email address of the recipient. 

2. Use the Rows combo box to choose the maximum number of results that 
the message should include. 

3. Click Submit to send the message. 

See Also 
o Using the Advanced Search of ER Objects 
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Writing an Advanced Search String 

Writing an Advanced Search String 
Search strings in ER/Studio Team Server: 

o Are not case-sensitive. For example, you get the same results when you search 
for good, Good or gOOd. 

o Support quoting text to match exact phrases. For example, "good idea" 
matches good idea, but not idea good or good or bad idea. 

o Support logic operators: OR, AND. 

o Support making mandatory or excluding words. 

o Support wildcard characters: *, ?. 

o Support the similarity and proximity character: ~. 

To use special characters as normal characters, such as using * as an asterisk and not as 
a wildcard character, see Escaping Special Characters. 

Using Logic Operators 
You can use OR or AND in your search strings: 

o OR matches if there is a match for any of the expressions at each side of the OR 
keyword. For example, searching for good OR idea returns the combination of 
the results of searching for good and the results of searching for idea: good, 
idea, good idea. 

o AND matches if there is a match for both expressions at each side of the AND 
keyword. For example, searching for good AND idea returns only the results that 
are among both the results of searching for good and the results of searching for 
idea: good idea, but not good or idea. 

Making Mandatory or Excluding Words 
By default, a match for a word is optional. The + and - symbols, used at the beginning of 
a word, change that: 

o + makes the word mandatory. For example, +apples oranges matches apples 
and oranges, apples, but not oranges. 

o - excludes the word. For example, -apples oranges matches oranges, but not 
apples or apples and oranges. 

Using Wildcard Characters 
When searching ER/Studio Team Server, you can use the asterisk (*) and the question 
mark (?) wildcard characters. This is how they work: 
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Writing an Advanced Search String 

o * represents 0 or more characters. For example, t*s matches tsunami, test or this. 

o ? represents a single character. For example, a?h matches agh or athletic, but 
not ah or argh. 

Note: The first character in a search string cannot be a wilcard character. 

Using the Similarity and Proximity Character 
Using ~ at the end of a word matches similar words as well. For example, land~ matches 
land, sand and band. 

Using ~ at the end of a quoted string, followed by a positive integer, matches results 
where the words within the string are within the specified number of words of each 
other. For example, "diagram update"~10 matches ER objects where diagram and 
update appear within 10 words of each other. 

Escaping Special Characters 
ER/Studio Team Server search features are powered by Apache Solr. There are some 
special characters that you must escape within a search string to use them as normal 
characters: + - && || ! ( ) { } [ ] ^ " ~ * ? : \. 

To use a special character as a normal character in a search string, you must escape the 
special character. To escape a special character, write a backslash (\) before the wildcard 
character in the search string. For example, searching for ABC\*DEF\?GHI matches the 
literal term ABC*DEF?GHI. 

See Also 
o Search Pages 

o Using the Advanced Search of ER Objects 

o Advanced Search 
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Working with ER Object Comments 

Working with ER Object Comments 
ER/Studio Team Server lets you access the comments that ER/Studio Repository users 
leave in ER objects. 

When you use a non-social user account, you can also watch ER objects for new 
comments, to receive an email whenever another user of ER/Studio Team Server or 
ER/Studio Repository adds a comment to the watched ER object. 

Additionally, if your ER/Studio Team Server installation does not have any license for 
Connect user connections (so it is not possible for any user to log in as a social user), you 
can add and delete comments from ER/Studio Team Server. 

Topics 
o See the Comments to an ER Object 

o Watching ER Objects for New Comments 

o Adding a Comment to an ER Object 

o Deleting a Comment from an ER Object 

See Also 
o Working with ER Object Labels 

 
Embarcadero Technologies  178 

http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Overview_of_User_Experiences%23Non-Social_Users
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Overview_of_User_Connections
http://docwiki.embarcadero.com/TeamServer/ERStudio/XE7/en/Overview_of_User_Experiences%23Social_User


Adding a Comment to an ER Object 

Adding a Comment to an ER Object 
If your ER/Studio Team Server installation does not have a license for Team Server user 
connections (so it is not possible for the user to log in as a social user), you can add 
comments to ER objects from ER/Studio Team Server. 

Comments let you describe the purpose of ER objects, and highlight certain features to 
which you want to draw attention. For example, you may want to use comments to 
provide feedback to the author of the model. 

Note: Only non-social users can add comments following the instructions described 
in this page. If you have a social user profile, you can add comments using the 
Discussions Tab at the navigation sidebar, as explained in Starting a Discussion about a 
Resource. For more information, see Using Social Features. 

To add a comment to an ER object: 

1. Go to the description page of the target ER object. 

2. Expand the Comments section, at the bottom of the page. 

3. Click Add comment. A text field and two buttons appear. 

4. Write your comment in the text field. 

5. Click Add to add your comment to the ER object. 

Your comment is added to the target ER object description page, where any other non-
social user can see it. 

Super users can configure ER/Studio Team Server so that your comments are not 
published until a super user reviews them. In that case, you receive the following 
message after you write a comment to an ER object: 

"Comment added. It will be viewable once the moderator has approved it." 

For more information, see Comment Moderation Page. 

Note: When you synchronize ER/Studio Team Server with ER/Studio Repository, 
comments are synchronized as well. Synchronization works both ways: comments in 
ER/Studio Team Server become available in ER/Studio Data Architect or ER/Studio 
Business Architect, and comments in ER/Studio Data Architect or ER/Studio Business 
Architect become available in ER/Studio Team Server. 

See Also 
o Watching ER Objects for New Comments 

o Deleting a Comment from an ER Object 

o See the Comments to an ER Object 
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Deleting a Comment from an ER Object 

Deleting a Comment from an ER 
Object 
You can delete your own comments or, if you are a super user, you can delete any 
comment. To delete a comment: 

1. Go to the description page of the target ER object. 

2. Expand the Comments section, at the bottom of the page. 

3. Click the button on the right-hand side of the comment box. 

4. When asked for confirmation, click OK to delete your comment. 

See Also 
o Adding a Comment to an ER Object 
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See the Comments to an ER Object 

See the Comments to an ER Object 
To see the comments to an ER object, do either of the following: 

o In the Model Explorer page, click the icon to the right-hand side of the target 
ER object. The Comments page opens with the comments associated with the 
target ER object. 

o If your ER/Studio Team Server installation does not have any license for social 
user connections, you can also go to the description page of the target ER object 
and expand the Comments section. 

See Also 
o Adding a Comment to an ER Object 

o Watching ER Objects for New Comments 
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Watching ER Objects for New Comments 

Watching ER Objects for New 
Comments 
When you watch an ER object for new comments, ER/Studio Team Server sends you an 
email notification when someone posts a new comment on the ER object. 

To start watching an ER object for new comments: 

1. Open the page of the target ER object. You can search for it. 

2. Click , on the top-right corner, to start watching the target ER object.  

Note: If the icon on the top-right is , you are already watching the target ER object. 

Remember to configure the email address where you want to receive updates about 
new comments on the target ER object. 

See Also 
o Changing Your Email Address for Notifications 

o Adding a Comment to an ER Object 

o See the Comments to an ER Object 

o Following Resources 
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Working with ER Object Labels 

Working with ER Object Labels 
If your ER/Studio Team Server installation does not have any license for social user 
connections (so it is not possible for any user to log in as a social user), you can use 
labels to organize your ER objects or to mark them somehow. For example, you can 
label a set of ER objects that have something in common, so that you can later find them 
easily. 

To see the labels associated with an ER object, go to the description page of the target 
ER object and expand the Labels section. 

Topics 
o Editing the Labels of an ER Object 

See Also 
o Working with ER Object Comments 
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Editing the Labels of an ER Object 

Editing the Labels of an ER Object 
To edit the labels associated with an ER object: 

1. Go to the description page of the target ER object. 

2. Expand the Labels section, towards the bottom of the page. 

3. Click Add labels or Edit labels. It is the same action, the name depends on 
whether or not there are labels associated with the current ER object already. 

4. You are now in edit mode. Now you can add and remove labels to the current ER 
object. 

5. When you are finished editing the ER object labels, click Done to save the 
changes. 

When you are in edit mode: 

o You can enter a label in the text field and click Add to associate the entered 
label with the current ER object. 

o Under the text field, you can see a list of existing labels from other ER objects (if 
any). Click a label from the list to associate it with the current ER object. 

o To remove a label from the current ER object, click the button to the right-
hand side of the target label. 
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Working with Data Sources 

Working with Data Sources 
Data sources are sets of data that define how to establish a connection to a specific 
database. 

Topics 
o Creating a Data Source 

o Data Source Fields for a Specific Database Management System 

o Searching for a Data Source 

o Editing a Data Source 

o Associating a Data Source with an ER Model 

o Associating a Data Source with a Login Credential 

o Discussing Data Sources 

o Following Data Sources 

o Editing the Stewards of a Data Source 

o Adding an Attachment Attribute to Data Sources 

o Deleting a Data Source 

See Also 
o Data Sources search page 

o Data Source Pages 

o Login Credentials 
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Associating a Data Source with an ER Model 

Associating a Data Source with an ER 
Model 
To associate a Data Source with an ER Model: 

1. Open the ER Objects page from the Navigation bar. In the left Navigation Bar, 
filter by Models. 

2. Click on the Model that you would like to associate with the Data Source. 

3. Open the Related Data Sources subpage. 

4. Open the Relate tab. The tab contains a search page, similar to the ER Objects 
page. 

5. In the list of Data Sources, click Relate on the right side of a Data Source to 
associate it with the current ER Model.  

Notes: 

 You can use the search field at the top of the subpage to filter the list of existing 
Data Sources. 

 You can click Unrelate on the right side of a Data Source to break its relation 
with the current ER Model. 

See Also 
o Creating a Data Source 

o Data Sources search page 
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Associating a Data Source with a Login Credential 

Associating a Data Source with a Login 
Credential 
The Related Data Sources subpage of Login Credentials lists the Data Sources that are 
either related to the current Login Credential, or that can be related to the Login 
Credential. 

You can use the Related Data Sources page to relate or unrelate Data Sources to the 
current Login Credential. 

The page is divided in two tabs: 

 

View Tab 
The View Tab displays a list of related Data Sources. The list shows the Data Sources 
currently related to the selected Login Credential. 

 

Relate Tab 
The Relate Tab allows you to relate and unrelate Data Sources to the current Login 
Credential. 

The Relate tab contains a list of Data Sources that can be related to the Login 
Credential. The list is arranged with alphabetical navigation and contains a search box. 

On the right side of the Data Sources entries, you can click Relate to relate a Data 
Source to the current Login Credential, or you can click Unrelate to unrelate the target 
Data Sources from the current Login Credential. 

 

See Also 
o Data Source Pages 
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Associating a Data Source with a Login Credential 

o Login Credential Pages 

o Working with Login Credentials 
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Creating a Data Source 

Creating a Data Source 
To create a data source: 

1. Select Data Sources. 

2. Click the New Data Source button on the upper-right corner. 

3. On the New Data Source dialog box that opens:  

1. Enter a Name for your new data source. Names of data sources in 
ER/Studio Team Server must be unique. 

2. Select from the Type combo box the database management system 
(DBMS) that stores the database. 

3. Fill the fields after the Type field and before the Custom Properties field. 
These fields change depending on the selected DBMS Type. See Data 
Source Fields for a Specific Database Management System. 

4. Optionally, under Custom Properties, you can define custom properties 
for the data source. For each property:  

1. Enter the Name of the property. 

2. Enter the Value for the property. 

3. Click Add to add the defined property-value pair to the list of 
properties of the data source. 

5. Write a Description that provides detailed information about the data 
source, such as its purpose and audience. 

6. Click Save to save your new data source. 

See Also 
o Deleting a Resource 

o New Data Source dialog box 
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Data Source Fields for a Specific Database Management System 

Data Source Fields for a Specific 
Database Management System 
The following tables provide details about the data source fields that are specific to a 
database management system: DB2 LUW, DB2 z/OS, InterBase, Firebird, JDBC, MySQL, 
ODBC, Oracle, SQL Azure, SQL Server, Sybase, Sybase IQ. 

You can access these fields when you create a data source or when you access the 
description page of an existing data source. 
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Data Source Fields for a Specific Database Management System 

DB2 LUW 
Item Description 

Use DB2 client 
aliases 

Check Enable to allow using DB2 client aliases. 

Host Name IP address or host name of the database server. 

Port Network port where the database server is listening. 

Remote DB Name Name of the target database. 

Schema ID Identifier of the target schema. 

Functional Path The functional path. 

OS Authentication Check Enable to log in to the database with the credentials of a user of the 
operating system where DB2 LUW is running. 

DB2 z/OS 
Item Description 

Use DB2 client 
aliases 

Check Enable to allow using DB2 client aliases. 

Host Name IP address or host name of the database server. 

Port Network port where the database server is listening. 

Remote DB Name Name of the target database. 

Schema ID Identifier of the target schema. 

Functional Path The functional path. 

OS Authentication Check Enable to log in to the database with the credentials of a user of the 
operating system where DB2 z/OS is running. 

InterBase 
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Data Source Fields for a Specific Database Management System 

Item Description 

Host Name IP address or host name of the database server. 

Port Network port where the database server is listening. 

Character Set Character set of the database. 

Dialect Dialect of the database. 

Role Role to access the database. 

Database file path Path to the database file. 

Firebird 
Item Description 

Host Name IP address or host name of the database server. 

Port Network port where the database server is listening. 

Character Set Character set of the database. 

Dialect Dialect of the database. 

Role Role to access the database. 

Database file path Path to the database file. 

JDBC 
Item Description 

Connection URL URL to connect to the database. 

MySQL 
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Data Source Fields for a Specific Database Management System 

Item Description 

Host Name IP address or host name of the database server. 

Port Network port where the database server is listening. 

Default Database Name of the target database. 

Windows 
Authentication 

Check Enable to use native Windows authentication to connect to the 
target database. 

ODBC 
Item Description 

Use DSN Check Enable to use DSN to connect to the target database. 

Connection String String that defined how to connect to the target database. 

Oracle 
There are four different ways you can connect to an Oracle database. Use the Use 
combo box to select the system you want to use: Alias, Connect Descriptor, SID, Service 
Name. 
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Data Source Fields for a Specific Database Management System 

Connecting to Oracle with Alias 

Item Description 

TNSNames.ora Alias Alias to connect to the database. 

Instance Name Name of the database instance. 

Role Role to connect to the database. 

Windows 
Authentication 

Check Enable to use native Windows authentication to connect to the 
target database. 

Connecting to Oracle with Connect Descriptor 

Item Description 

Connect Descriptor Description of the connection to the database. 

Instance Name Name of the database instance. 

Role Role to connect to the database. 

Windows 
Authentication 

Check Enable to use native Windows authentication to connect to the 
target database. 

Connecting to Oracle with SID 

Item Description 

Host Name IP address or host name of the database server. 

SID Oracle system identifier that uniquely identifies the target database. 

Port Network port where the database server is listening. 

Instance Name Name of the database instance. 

Role Role to connect to the database. 

Windows 
Authentication 

Check Enable to use native Windows authentication to connect to the 
target database. 

Connecting to Oracle with Service Name 
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Data Source Fields for a Specific Database Management System 

Item Description 

Host Name IP address or host name of the database server. 

Service Name Service name that identifies the target database. 

Port Network port where the database server is listening. 

Instance Name Name of the database instance. 

Role Role to connect to the database. 

Windows 
Authentication 

Check Enable to use native Windows authentication to connect to the 
target database. 

SQL Azure 
Item Description 

Host Name IP address or host name of the database server. 

Default Database Name of the target database. 

SQL Server 
Item Description 

Host Name IP address or host name of the database server. 

Port Network port where the database server is listening. 

Protocol Protocol to use for the network connection. You can choose any of the 
following options: 

o TCP/IP (default). Standard network protocol. 

o Name Pipes. Windows-specific network protocol. 

Encryption Check Enable to encrypt the network communication. 

Default Database Name of the target database. 

Packet Size Size of the network packets. 

Windows 
Authentication 

Check Enable to use native Windows authentication to connect to the 
target database. 

Sybase 
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Data Source Fields for a Specific Database Management System 

Item Description 

Use Sybase SQL.INI 
aliases 

Check Enable to use Sybase SQL.INI aliases. 

Host Name IP address or host name of the database server. 

Port Network port where the database server is listening. 

Encryption Check Enable to encrypt the network communication. 

Default Database Name of the target database. 

Packet Size Size of the network packets. 

Max Connections Maximum number of connections that can be established. 

Character Set Character set of the database. 

Kerberos 
Authentication 

Check Enable to use the Kerberos network authentication protocol to 
connect to the target database. 

Sybase IQ 
Item Description 

Host Name IP address or host name of the database server. 

Port Network port where the database server is listening. 

Database Name of the target database. 

Windows 
Authentication 

Check Enable to use native Windows authentication to connect to the 
target database. 

See Also 
o Creating a Data Source 

o Data Source Description page 
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Working with Login Credentials 

Working with Login Credentials 
Login Credentials are security containers that store and manage passwords for 
accessible Data Sources from ER/Studio Team Server. Login Credentials contain an alias 
that identifies the credential for sharing. 

Only users with Update/Delete permission on Data Sources are able to edit Login 
Credentials. Any password changes are invisible for common users. 

To see the details of an Login Credentials, browse to it and open the corresponding 
Login Credential page. 

Note: Only Team Server DBArtisan Edition licenses will show this feature 

Topics 
o Creating Login Credentials 

o Editing Login Credentials 

o Deleting Login Credentials 

o Browsing Login Credentials 

o Associating a Login Credential with a Data Source 

See Also 
o Login Credential Pages 

o Login Credentials Search Page 

o Data Sources 
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Creating Login Credentials 

Creating Login Credentials 
To create a Login Credentials: 

1. Select the Data Sources search page and then select Related Login Credentials 
on the left-hand sidebar. 

2. Click the New Login Credentials button on the upper-right corner. 

3. On the New Login Credentials dialog box that opens:  

1. Define the Name of your new Login Credential. 

2. Choose the type of authentication you prefer:  

 Type the User Name. User Name is a login name for a Data 
Source. Then enter and confirm the Password. The password that 
allows access to the Data Source. For platforms that may not 
require a password such as Sybase, this field may be left empty. 

 Select OS Authentication. This option disables Name, Password 
and Confirm Password fields since the information will be read 
from the current OS login. Trusted Host field appears. 

Note: Include the name of the host in Trusted Host in case your server requires it. If 
you do not include it when necesary, ER/Studio Team Server will show the exception 
that your database server provides 

3. Define a Role for the Login Credential. 

4. Write a Definition that provides detailed information about the Login 
Credential, such as its purpose and users group. 

5. Click Save to save your new Login Credential. 

See Also 
o Associating a Login Credential with a Data Source 

o Deleting Login Credential 

o Login Credentials Search page 
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Editing a Resource 

Editing a Resource 
To edit a glossary, a term, or a data source: 

1. Open the page of the target resource. You can search for it. 

2. Open the Description subpage. 

3. Click Edit to enter the edit mode. In edit mode, the Description page provides 
fields to define the values of each property of the target resource. 

4. Modify the resource properties.  

Tip: For information about the fields that you can edit, check the documentation of the 
description page of the type of resource that you are editing: glossary, term, or data 
source. 

5. To save your changes, click Save at the end of the page. 

Note: To automatically update any matched items to the edited changes, the Auto 
Match tick box on the Found In tab must be enabled. 

See Also 
o Editing the Stewards of a Resource 

o Working with Glossaries 

o Working with Terms 

o Working with Data Sources 
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Deleting Login Credentials 

Deleting Login Credentials 
You can delete a Login Credential if you have proper permissions or if you are a super 
user. 

To delete a Login Credentials from ER/Studio Team Server: 

1. Open the page of the target Login Credential. You can search for it. 

2. On the Login Credential page, click [Delete] on the header. 

3. On the confirmation dialog box that opens, click OK. 

The target Login Credential is not available anymore in ER/Studio Team Server. 

Note: Deleting a Login Credential does not delete the Data Source associated with it. 

See Also 
o Creating Login Credentials 

o Related Login Credentials 
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Browsing Login Credentials 

Browsing Login Credentials 
To search for Login Credentials: 

1. Select the Data Sources search page and then select Login Credentials on the 
left-hand sidebar. 

2. Enter your search Login Credentials in the search field. 

As soon as you stop typing, ER/Studio Team Server filters the list of Login Credentials 
and displays only the ones that meet your search criteria. Click their name to open their 
resource page. 

See Also 
o Search Pages 
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Related Login Credentials 

Related Login Credentials 

 
The Related Login Credentials subpage of Data Sources lists the Login Credentials 
that are either related to the current Data Source, or that can be related to the Data 
Source. 

You can use the Related Login Credentials page to relate or unrelate Login Credentials 
to the current Data Source. 

The page is divided in two tabs: 

View Tab 
The View Tab displays a list of related Login Credentials. The list shows the Login 
Credentials currently related to the selected Data Source. From here you can test 
connection to the current Data Source with each related Login Credential . 

 

Relate Tab 
The Relate Tab allows you to relate and unrelate Login Credentials to the current Data 
Source. 

The Relate tab contains a list of Login Credentials that can be related to the Data 
Source. The list is arranged with alphabetical navigation and contains a search box. 

On the right side of the Login Credentials entries, you can click Relate to relate a Login 
Credential to the current Data Source, or you can click Unrelate to unrelate the target 
Login Credential from the current Data Source. 

 

See Also 
o Data Source Pages 
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Login Credential Pages 

Login Credential Pages 
Login Credential pages provide information about them: Description and Related Data 
Sources. 

To open a Login Credential page, follow a Login Credential link. If you are looking for a 
specific Login Credential, you can use the Login Credentials Search page . 

Login Credentials pages share a common header, and they also share a common 
sidebar. When you click the items in the sidebar, you get access to information pages 
about different aspects of the target Login Credential. 

Login Credentials Pages Header 

 

The Login Credential header shows: 

o The Login Credential icon. 

o The name of the Login Credential. 

o The type of resource ("Login Credentials"). 

o If you have proper permissions or if you are a super user, you can click [Delete] 
to delete the Login Credential. 

Login Credentials Pages Sidebar 
Login Credentials pages provide a sidebar with the following items: 
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Login Credential Pages 

Item Description 

 
Description 

Provides detailed information about the Login Credential. 

 
Related Data 
Sources 

Shows a list of data sources that are associated with the current Login 
Credential . 

 
Permissions 

Opens the users and groups permissions tab for the login credential. 

See Also 
o Working with Login Credentials 
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Working with Groups 

Working with Groups 
Groups are designed as a shortcut to get in touch with other elements. It also allows you 
to have related elements concentrated in one place. 

When you create a group, you become its owner. You can then include in your group 
different types of resources. To see the details of an existing group, find it and open its 
group page. 

Topics 
o Creating a Group 

o Searching for a Group 

o Editing a Group 

o Including Data Sources into a Group 

o Discussing Groups 

o Following Groups 

o Editing the Stewards of a Group 

o Deleting a Group 

o Manage Permissions for a Group 

See Also 
o Group Pages 

o Working with Resources 
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Creating a Group 

Creating a Group 
To create a group: 

1. Select Data Sources. 

2. Click the New Group button on the upper-right corner. 

3. In the New Group dialog box that opens:  

1. Enter a Name to identify your new group. 

2. Define the Status of the group using nomenclature you decide upon. You 
can use for example the following nomenclature: "Approved", "Not Yet 
Approved", "Implemented", "Not Yet Implemented", and 
"Deprecated". 

3. Write a Definition that provides detailed information about the group, 
such as its purpose and audience. 

4. Click Save to save your new group. 

See Also 
o Including Data Sources into a Group 

o Deleting a Group 

o New Group Dialog Box 
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Including Data Sources into a Group 

Including Data Sources into a Group 
To include a Data Source into an existing group: 

1. Open the page of the target group. You can search for it. 

2. Open the Included Data Sources subpage. 

3. Open the Include tab. 

4. In the list of existing data sources, click Include on the right-hand side of a 
resource to include it into the group.  

Notes: 

 You can use the search field at the top of the page to filter the list of existing 
resources. 

 You can click Exclude on right-hand side of a resource to remove the resource 
from the current group. 

See Also 
o Creating a Group 
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Working with Apps 

Working with Apps 
Apps allow you to create your own functional applications within ER/Studio Team 
Server. 

When you create an App you become its owner. Only you or a super user can edit or 
delete the application. To see the details of an existing application, find it and open its 
App page. 

Topics 
o Creating an App 

o Searching for an App 

o Editing an App 

o Discussing Apps 

o Following Apps 

o Editing the Stewards of an App 

o Deleting an App 

 

See Also 
o Apps search page 

o App Pages 
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Creating an App 

Creating an App 
To create an App: 

1. Select Apps. 

2. Click the New App button on the upper-right corner. 

3. In the New App dialog box that opens:  

1. Enter a Name to identify your new app. 

2. Define the Status of the app using nomenclature you decide upon. You 
can use for example the following nomenclature: "Approved", "Not Yet 
Approved", "Implemented", "Not Yet Implemented", and 
"Deprecated". 

3. Write a Definition that provides detailed information about the app, such 
as its purpose and audience. 

4. Click Save to save your new app. 

Now you can add script to your app using the Server Code link on the left navigation 
bar. 

See Also 
o Apps 

o Developer Guide 
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Troubleshooting 

Troubleshooting 
Here you can find a list of some frequently encountered problems and their solutions or 
workarounds. 

Most problems can be fixed by making sure that your system is running the latest 
software. Before you start troubleshooting, it is advised that you make sure your product 
is up to date. 

Cannot Connect to ER/Studio Team Server 

Unable to Connect 

If your web browser cannot establish a connection to the ER/Studio Team Server 
server: 

o Check that the URL you are trying to access is ER/Studio Team Server's. 

o Check that your system has a working connection to the ER/Studio Team Server 
server. 

o Check that ER/Studio Team Server is running. See Starting ER/Studio Team 
Server. 

o Try increasing the maximum memory assigned to ER/Studio Team Server. See 
Changing the Memory Limit of ER/Studio Team Server. 

Template Could Not be Loaded 

"Template could not be loaded..." 

If you get this error message, you might need to restart the ER/Studio Team Server 
server. Contact your super user. 

ER/Studio Team Server is not showing the Start 
Here page 
Start Here page may be not shown fisrt time you access to home page using https 
conection. To solve this and obtain the certificate open https://www.embarcadero.com 
on the same browser and then refresh ER/Studio Team Server home page. 
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Loading Pages Takes Too Much Time 
Try increasing the maximum memory assigned to ER/Studio Team Server. See 
Changing the Memory Limit of ER/Studio Team Server. 

Log Error Messages 
There are some log files in the ER/Studio Team Server installation folder that you can 
watch for error messages and warnings. Here you can see some errors that you might 
see registered in those log files, what the errors mean, and how to solve them. 

tomcat\logs\<domain>.<date>.log 

java.lang.OutOfMemoryError: Java heap space 

You need to increase the maximum memory assigned to ER/Studio Team Server. See 
Changing the Memory Limit of ER/Studio Team Server. 
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etlvar\log\log_<timestamp>\*.log 

<date> - SyncDiagram.bat (stdout) - Could not reserve enough space for 
object heap 

The application cannot start because there is not enough contiguous memory in the 
system that can be allocated for the application. For example, you are using a virtual 
machine and have more memory allocated to ER/Studio Team Server than is available 
on the virtual machine. 

You need to decrease the maximum memory assigned to ER/Studio Team Server. See 
Changing the Memory Limit of ER/Studio Team Server. 

Synchronization Issues 
Oracle 
The default number of processes that can be set in Oracle XE is 40. If you exceed the 
amount of processes you may get a failure, identified in the synchronization logs as ORA-
12519, TNS:no appropriate service handler found. The synchronization logs are available 
in the installation dir\etlvar directory.  

 
To fix this error you can increase the number of available processes by doing the 
following: 

1. Run SQL*Plus and login as SYSTEM. You should know what password you’ve 
used during the installation of Oracle DB XE. 

2. Run the command  
3.  
4.  “ALTER SYSTEM SET processes=150 scope=spfile;” 
5.  

in the SQL*Plus 

6. Restart the database. 

If you continue to get this error after increasing the number of available processes by 
following the above procedure, you may be using up all available processes and need 
to source the reason for this by examining the processes. 

Connect to your database either using the sys account or by logging into your Oracle 
server and using a direct SQL Plus connection as the Oracle user: sqlplus / as sysdba. 

Note: If you are still getting errors regarding no available processes, you will have 
to manually kill one of the Oracle processes using the kill command. Then use these two 
queries to find out how many processes and sessions are currently logged: 
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1 SELECT COUNT(*) FROM v$process; 
2 SELECT COUNT(*) FROM v$session; 
 

For Oracle 11g, the default maximum number of processes is 150 (149 available). 

Once you have confirmed that you have definitely reached the maximum number of 
processes, you can use this query to see what they all are and if they are active: 
 
1 SELECT sess.process, sess.status, sess.username, sess.schemaname, 
SQL.sql_text 
2 FROM v$session sess,  v$sql     SQL 
3 WHERE SQL.sql_id(+) = sess.sql_id; 
 

See Also 
o Overview of the ER/Studio Team Server Tools 

o Overview of Data Synchronization 
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Glossary 

Glossary 
Here you can find information about some of the terms that you may run into while you 
browser the documentation. 

A 
Apache Tomcat 

Server technology used by ER/Studio Team Server. More information. 

B 
Breadcrumb trail 

A breadcrumb trail is a structured display of resources where the resource to the left is a 
parent of the resource to the right. 

 

 
Business Reports 

This is one of the folders of shared reports distributed with ER/Studio Team Server. See 
Solution Browser, Business Reports. 

C 
Connection Types 

These are the type of connections that people can use to connect to ER/Studio Team 
Server. Not to be confused with user types. See Overview of User Connections. 
CRUD 

Create, Read, Update, Delete usage relationships. 

D 
Diagram 

A graphical presentation of a collection of model elements. 
Digital Certificate 

A digital certificate (also known as a public key certificate or identity certificate) is an 
electronic document that uses a digital signature to bind a public key with identity 
information. The certificate can be used to verify that a public key belongs to an 
individual. You can view installed certificates in Firefox > Options > Advanced Menu.  
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E 
ETL 

Extraction, Transformation and Load, a process in data warehousing that involves 
extracting data from other sources, transforming it to fit business need, and then 
loading it into an end target, such as the data warehouse. 

L 
Logical Model 

A logical entity-relationship model conforms to relational theory and contain only fully-
normalized entities. For a logical data model to be normalized, it must include the full 
population of attributes to be implemented and those attributes must be defined in 
terms of their domains or logical data types. 

A logical data model requires a complete schema of identifiers or candidate keys for 
unique identification of each occurrence in every entity. The logical model indicates the 
current identify selection because there are choices of identifiers for many entities. 

P 
Pentaho BI Platform 

Architecture and infrastructure to build solutions to business intelligence (BI) problems. 
ER/Studio Team Server builds its reporting features on top of this platform. More 
information. 
Permissions 

Gives a user the ability to access the Reporting Repository database. See Overview of 
User Roles. 
Physical Model 

A complete physical data model includes all the database artifacts required to create 
relationships between tables and achieve performance goals, such as indexes, constraint 
definitions, linking tables, partitioned tables, and clusters. 

R 
Roles 

ER/Studio Team Server provides default roles. These roles are granted permissions to 
access actions. The default roles are Authenticated and Super User. See Overview of 
User Roles. 
Repository 

A database where ER/Studio Team Server stores and maintains data. For ER/Studio 
Team Server, the database, or repository, is associated with the ER/Studio application. 
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S 
Security 

All users are authenticated before they are able to run queries and reports. Each user 
must have a user name and password that is stored in the ER/Studio Repository 
database. 
Solution 

A set of documents defining the processes and activities required to solve a specific 
business intelligence problem. 
Solution Repository 

The Solution Repository is the location where solutions and the metadata they rely on is 
stored and maintained. Requests made to the platform to have actions executed rely on 
the action being defined in the Solution Repository. 
Scheduler 

Administrative function to schedule and monitor synchronization of the ER/Studio 
Repository with the Reporting Database. See Overview of Scheduling. 

T 
Technical Reports 

This is one of the folders of shared reports distributed with ER/Studio Team Server. See 
Solution Browser, Technical Reports. 

See Also 
o What Is ER/Studio Team Server 

o Overview of the ER/Studio Team Server Architecture 
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